# Contents

**About This Manual** .................................................................................................................................................................................4

- Safety Information .................................................................................................................................................................................5
- Manuals ..................................................................................................................................................................................................6
- Trademarks ................................................................................................................................................................................................8
- Manufacturer .......................................................................................................................................................................................9
- Symbols Used in This Manual ..............................................................................................................................................................10
- Arrow Symbols in This Manual ..........................................................................................................................................................11
- Screen Examples in This Manual ........................................................................................................................................................12
- Abbreviations Used in This Manual ................................................................................................................................................13

**What You Can Do with the ScanSnap** ......................................................................................................................................................14

**Scanning a Document** .............................................................................................................................................................................17

**Scanning Documents with the ScanSnap by Inserting Two Documents at a Time or by Inserting the Next Document While the Current Document Is Being Scanned** ............................................................................................................22

**Scanning Documents Larger Than A4 or Letter Size (by Directly Inserting Them in the ScanSnap)** ........................................................................................................................................................................28

**ScanSnap Overview** ................................................................................................................................................................................32

- Parts and Functions ................................................................................................................................................................................33
- Charging the Battery ................................................................................................................................................................................36
- System Requirements ............................................................................................................................................................................38
- Overview of the Software Related to the ScanSnap ................................................................................................................................39
- How to Install the Software ..................................................................................................................................................................40
- ScanSnap Manager Icon ........................................................................................................................................................................41
- ScanSnap Manager Menu ....................................................................................................................................................................42
- ScanSnap Setup Window .......................................................................................................................................................................44
- Turning the ScanSnap On or Off ............................................................................................................................................................45
  - Turning the ScanSnap On ..................................................................................................................................................................46
  - Turning the ScanSnap Off .................................................................................................................................................................48
  - Sleep Mode .......................................................................................................................................................................................49
  - Automatic Power OFF .....................................................................................................................................................................50
  - Checking the Remaining Battery Power .........................................................................................................................................51
- Connecting the ScanSnap via Wireless LAN .........................................................................................................................................52
  - Preparation ....................................................................................................................................................................................53
  - Setting a Wireless LAN Using the ScanSnap Wireless Setup Tool ................................................................................................54
  - Connecting a Computer in Access Point Connect Mode ........................................................................................................55
  - Connecting a Mobile Device in Access Point Connect Mode ..................................................................................................57
  - Connecting a Computer in Direct Connect Mode ...................................................................................................................58
  - Connecting a Mobile Device in Direct Connect Mode ............................................................................................................60
  - Reconnecting to a Wireless Access Point Using the ScanSnap WPS Button ..............................................................................61
- Documents to Scan ..................................................................................................................................................................................63
  - Documents That Can Be Loaded Directly into the ScanSnap .....................................................................................................64
  - Documents That Can Be Scanned Using the Carrier Sheet .......................................................................................................66

**What You Can Do with Related Software** ...........................................................................................................................................68

**What You Can Do with the ScanSnap Organizer** ...................................................................................................................................69

**Basic Operation Procedure of ScanSnap Organizer** ................................................................................................................................70
About This Manual

- "Safety Information" (page 5)
- "Manuals" (page 6)
- "Trademarks" (page 8)
- "Manufacturer" (page 9)
- "Symbols Used in This Manual" (page 10)
- "Arrow Symbols in This Manual" (page 11)
- "Screen Examples in This Manual" (page 12)
- "Abbreviations Used in This Manual" (page 13)
Safety Information

The attached "Safety Precautions" manual contains important information about the safe and correct use of the ScanSnap. Make sure that you read and understand it before using the ScanSnap.
Read the following manuals according to your needs when using the ScanSnap.

### Before Using the ScanSnap

<table>
<thead>
<tr>
<th>Manual</th>
<th>Description and Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safety Precautions</td>
<td>This manual contains important information about the safe use of the ScanSnap. Make sure you read this manual before using the ScanSnap. In addition, when the software is already installed, this manual can be accessed as follows: From the sidebar in Finder, select [Applications] → [ScanSnap Manuals], and then double-click [iX100 Safety Precautions].</td>
</tr>
</tbody>
</table>

### When Setting Up the ScanSnap

<table>
<thead>
<tr>
<th>Manual</th>
<th>Description and Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>ScanSnap iX100 Getting Started</td>
<td>This manual explains the setup procedure from the moment you open the package to testing the operations. In addition, when the software is already installed, this manual can be accessed as follows: From the sidebar in Finder, select [Applications] → [ScanSnap Manuals], and then double-click [iX100 Getting Started].</td>
</tr>
</tbody>
</table>

### When Operating the ScanSnap

<table>
<thead>
<tr>
<th>Manual</th>
<th>Description and Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>ScanSnap iX100 Basic Operation Guide (this manual)</td>
<td>This manual explains the basic operations and cleaning procedure for the ScanSnap.</td>
</tr>
<tr>
<td>ScanSnap Manager Help</td>
<td>This Help file describes the windows, operational troubles and the solutions, as well as messages of the ScanSnap Manager. This manual can be accessed by one of the following methods:</td>
</tr>
<tr>
<td></td>
<td>● Click the ScanSnap Manager icon in the Dock while holding down the [control] key on the keyboard, and select [Help] → [Help] from the <em>ScanSnap Manager Menu</em> (page 42).</td>
</tr>
<tr>
<td></td>
<td>● Click the Help button ( ) for ScanSnap Manager.</td>
</tr>
<tr>
<td></td>
<td>● Select [Help] in the menu bar → [ScanSnap Manager Help].</td>
</tr>
<tr>
<td>ScanSnap Wireless Setup Tool Help</td>
<td>This Help file explains about operations, operational troubles and their solutions, windows, and messages of the ScanSnap Wireless Setup Tool. Click the Help button ( ) in each window.</td>
</tr>
</tbody>
</table>
### When Saving Scanned Images to a Mobile Device

<table>
<thead>
<tr>
<th>Manual</th>
<th>Description and Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>ScanSnap Basic Operation Guide (Mobile Connection for iOS)</td>
<td>This manual describes operations to be performed on an iOS-based mobile device when you save scanned images to the mobile device.</td>
</tr>
<tr>
<td></td>
<td>This manual can be accessed by the following method:</td>
</tr>
<tr>
<td></td>
<td>1. Start up ScanSnap Connect Application on the mobile device.</td>
</tr>
<tr>
<td></td>
<td>- The [File List] screen appears.</td>
</tr>
<tr>
<td></td>
<td>2. Tap ↓.</td>
</tr>
<tr>
<td></td>
<td>- The [Information] screen appears.</td>
</tr>
<tr>
<td></td>
<td>3. Tap the [Help] button.</td>
</tr>
</tbody>
</table>

| ScanSnap Basic Operation Guide (Mobile Connection for Android) | This manual describes operations to be performed on an Android-based mobile device when you save scanned images to the mobile device.                                                                                      |
|                                                              | This manual can be accessed by the following method:                                                                                                                                                                      |
|                                                              | 1. Start up ScanSnap Connect Application on the mobile device.                                                                                                                                                         |
|                                                              |   - The [File List] screen appears.                                                                                                                                                                                    |
|                                                              | 2. Tap ↓.                                                                                                                                                                                                                  |
|                                                              |   - The menu appears.                                                                                                                                                                                                   |
|                                                              | 3. Tap [Help].                                                                                                                                                                                                            |

### When Updating the Software

<table>
<thead>
<tr>
<th>Manual</th>
<th>Description and Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>ScanSnap Online Update Help</td>
<td>This Help file describes the operations, windows, and messages of ScanSnap Online Update.</td>
</tr>
<tr>
<td></td>
<td>This Help file can be accessed by one of the following methods:</td>
</tr>
<tr>
<td></td>
<td>- Click the Help button ( ) of ScanSnap Online Update.</td>
</tr>
<tr>
<td></td>
<td>- Select [Help] in the menu bar → [ScanSnap Online Update Help].</td>
</tr>
</tbody>
</table>

### When Using Related Applications

<table>
<thead>
<tr>
<th>Manual</th>
<th>Description and Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>ScanSnap Organizer Help</td>
<td>This Help file describes the operations, windows, and messages of ScanSnap Organizer.</td>
</tr>
<tr>
<td></td>
<td>This Help file can be accessed by selecting [Help] in the menu bar → [ScanSnap Organizer Help].</td>
</tr>
<tr>
<td>CardMinder Help</td>
<td>This Help file describes the operations, windows, and messages of CardMinder.</td>
</tr>
<tr>
<td></td>
<td>This Help file can be accessed by selecting [Help] in the menu bar → [CardMinder Help].</td>
</tr>
</tbody>
</table>
Trademarks

Microsoft, Windows, Windows Vista, Excel, PowerPoint, Outlook, SharePoint, Windows Live, Internet Explorer, and OneDrive are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.

Word is the product of Microsoft Corporation in the United States.

Apple, App Store, the Apple logo, Mac, Mac OS, OS X, macOS, iPad, iPhoto, iPod touch, and iTunes are trademarks of Apple Inc.

Intel and Intel Core are registered trademarks or trademarks of Intel Corporation in the United States and other countries.

ABBYY™ FineReader™ Engine © ABBYY. OCR by ABBYY

ABBYY and FineReader are trademarks of ABBYY Software, Ltd. which may be registered in some jurisdictions.

Evernote is a registered trademark or trademark of Evernote Corporation.

Google, Android, Google Play, and Google Drive are registered trademarks or trademarks of Google Inc. Use of these registered trademarks or trademarks is subject to Google Permissions.

Salesforce, the Salesforce logo, and Salesforce CRM are registered trademarks or trademarks of salesforce.com, inc. in the United States and other countries.

Wi-Fi, Wi-Fi Protected Setup, and the Wi-Fi Protected Setup logo are trademarks of Wi-Fi Alliance.

Amazon is a trademark of Amazon.com, Inc. or its affiliates.

Besides the software authored by the product developer (PFU Limited), the ScanSnap contains other free software created by third parties. For details concerning the conditions of the licenses, refer to "Terms and Conditions for End User License" (file name: OSS_License.pdf) contained in the installation folder of ScanSnap Manager.

ScanSnap, the ScanSnap logo, ScanSnap Manager, ScanSnap Organizer, CardMinder, and Rack2-Filer are registered trademarks or trademarks of PFU Limited in Japan.

Other company names and product names are the registered trademarks or trademarks of the respective companies.
Manufacturer

PFU Limited
YOKOHAMA i-MARK PLACE, 4-4-5 Minatomirai, Nishi-ku, Yokohama, Kanagawa, 220-8567, Japan
© PFU Limited 2014-2017
Symbols Used in This Manual

The following indications are used in this manual to obviate any chance of accident or damage to you and people near you, and your property. Warning labels indicate the warning level and statements. The symbols indicating warning levels and their meanings are as follows.

<table>
<thead>
<tr>
<th>Indication</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="CAUTION" /></td>
<td>This indication alerts operators of an operation that, if not strictly observed, may result in safety hazards to personnel or damage to the product.</td>
</tr>
</tbody>
</table>
Arrow Symbols in This Manual

Right-arrow symbols (→) are used to connect icons or menu options you should select in succession.

Example: From the sidebar in Finder, select [Applications] → [ScanSnap].
Screen Examples in This Manual

The screenshots used in this manual are of OS X El Capitan v10.11.
The actual windows and operations may differ depending on the operating system.
The screen examples in this manual are subject to change without notice in the interest of product development.
If the actual window differs from the screen examples in this manual, operate by following the actual displayed screen.
## Abbreviations Used in This Manual

Also, the following abbreviations are used in this manual.

<table>
<thead>
<tr>
<th>Abbreviation Used</th>
<th>Designation</th>
</tr>
</thead>
</table>
| Mac OS                                     | macOS High Sierra v10.13  
macOS Sierra v10.12  
OS X El Capitan v10.11 |
| Word                                       | Microsoft® Word 2016 for Mac  
Microsoft® Word for Mac 2011 |
| Excel                                      | Microsoft® Excel® 2016 for Mac  
Microsoft® Excel® for Mac 2011 |
| PowerPoint                                 | Microsoft® PowerPoint® 2016 for Mac  
Microsoft® PowerPoint® for Mac 2011 |
| ABBYY FineReader for ScanSnap               | ABBYY FineReader for ScanSnap™  
All the descriptions in this manual assume the usage of ABBYY FineReader for ScanSnap bundled with the ScanSnap. Unless otherwise specified, the term ABBYY FineReader for ScanSnap refers to the ABBYY FineReader for ScanSnap bundled with the ScanSnap.  
Note that ABBYY FineReader for ScanSnap may be upgraded without notice. If the descriptions in this manual differ from the actual displayed screens, refer to the ABBYY FineReader for ScanSnap User's Guide. |
| Google Drive                               | Google Drive™                                                                |
| Android                                    | Android™                                                                    |
| WPS                                        | Wi-Fi Protected Setup™                                                      |
| Wireless access point                      | Wireless access point  
Wireless router |
| ScanSnap                                   | Color Image Scanner ScanSnap iX100                                           |
| Carrier Sheet                              | ScanSnap Carrier Sheet                                                      |
What You Can Do with the ScanSnap

**Scanning Multiple Documents Continuously**

When you scan multiple documents with the ScanSnap, you can scan one or two document at a time. To scan two documents at a time, you can insert two documents at a time or you can insert the next document while another document is being scanned.

- Scanning one document at a time
  After scanning a document is completed, when you insert the next document in the ScanSnap, the next scan is started automatically.
  For details, refer to "Scanning a Document" (page 17).

- Scanning documents by inserting two documents at a time or by inserting the next document while the current document is being scanned (dual scan)
  When scanning small size documents such as business cards and postcards, you can insert two documents at a time in the ScanSnap. Alternatively, you can insert the next document while another document is being scanned. In either method, you can scan up to 20 documents continuously in a single scanning operation.
  These scanning methods are referred to as dual scans.
  For details, refer to "Scanning Documents with the ScanSnap by Inserting Two Documents at a Time or by Inserting the Next Document While the Current Document Is Being Scanned" (page 22).

**Scanning Documents Larger Than A4 or Letter Size by Directly Inserting Them in the ScanSnap**

By folding an A3, B4, or Double Letter size document in half and scanning each side continuously, the scanned images of both sides can be automatically merged into a single image.
Scanned images can be merged only when there is text, diagram, or a table on the fold line of the folded document.

For details, refer to "Scanning Documents Larger Than A4 or Letter Size (by Directly Inserting Them in the ScanSnap)" (page 28).

---

**Scanning Documents That Cannot Be Inserted Directly in the ScanSnap**

You can use the optional Carrier Sheet to scan the following documents.

- Documents that are larger than A4/Letter size and not larger than A3 size
  
  For details, refer to "Scanning Documents Larger Than A4 or Letter Size (with the Carrier Sheet)" (page 90).

- Documents that can be damaged quite easily such as photographs, or non-standard size documents such as clippings
  
  For details, refer to "Scanning Documents Such as Photographs and Clippings" (page 95).
Connecting the ScanSnap via Wireless LAN

You can connect the ScanSnap and a computer or mobile device via wireless LAN.
To connect them, you can use either the Access Point Connect mode in which a wireless access point is used for connection or the Direct Connect mode in which a computer or mobile device is directly connected to the ScanSnap. Select a suitable connection mode depending on whether there is wireless LAN in a place where you use the ScanSnap or not.

To configure the wireless settings for the ScanSnap, use the ScanSnap Wireless Setup Tool, which is installed together with ScanSnap Manager.

For details, refer to "Connecting the ScanSnap via Wireless LAN" (page 52).

- Access Point Connect mode
- Direct Connect mode
Scanning a Document

The procedure for scanning documents by inserting one document at a time is as follows. For details about documents that can be scanned, refer to “Documents to Scan” (page 63).

1. **Open the feed guide of the ScanSnap.**

   ![Feed Guide](image)

   **HINT**
   - If you want the document to be ejected from the front of the ScanSnap or when there is not enough space where the document exits the ScanSnap, open the output guide.
   - For details about documents that can be scanned with the output guide open, refer to “Documents to Scan” (page 63).

   ![Output Guide](image)

   - How the document is ejected differs as below depending on whether the output guide is open or closed.
     - When the output guide is closed
     - When the output guide is open

   The [Scan/Stop] button flashes in blue. The button returns to being lit normally when document scanning is enabled.

   ![Scan/Stop Button](image)

   In addition, the ScanSnap Manager icon in the Dock changes from 📁 to 📁.
2. Insert the document straight into the feeding section of the ScanSnap, with the scanning side facing up.

The document is pulled in until it is set inside the ScanSnap.

ATTENTION

- If you specify a standard size instead of selecting [Automatic detection] (default), insert the document by aligning it with the left edge of the feeding section. You can configure the scan settings in the “ScanSnap Setup Window” (page 44).

- When you perform scanning with the output guide closed, leave enough space at the back of the ScanSnap to allow the document to be completely ejected. In addition, when you scan long page documents, hold the scanned documents with your hands to prevent them from falling off the unit where the ScanSnap is placed on. Make sure that the area where the document exits the scanner is clear of any obstacles. Otherwise, paper jam may occur.

- If you scan the following documents with the output guide open, a paper jam may occur and damage the documents. Scan the following documents with the output guide closed.
  - Thick paper (80 g/m² [20 lb] or heavier)
  - Postcards
3. Press the [Scan/Stop] button on the ScanSnap to start scanning.

ATTENTION
Do not perform the following operations during scanning. Doing so will stop scanning.
- Connect or disconnect the ScanSnap and other USB devices.
- Close the feed guide.
- Switch users.
- Allow the computer to enter sleep mode.

* The [Scan/Stop] button on the ScanSnap flashes in blue while the documents are being scanned.

The [ScanSnap Manager - Image scanning and file saving] window appears.

* When scanning is complete, the [ScanSnap Manager - Image scanning and file saving] window displays a scanning standby status.
4. **Press the [Scan/Stop] button on the ScanSnap to finish scanning.**
   
   The Quick Menu appears.

5. **In the Quick Menu, click the icon of the application to link with ScanSnap Manager.**
   
   For details about linking the following applications with ScanSnap Manager, refer to "Useful Usages" (page 83).
   
   - ScanSnap Organizer
   - CardMinder
The selected application starts up. For details, refer to the Advanced Operation Guide.

**ATTENTION**
- You cannot start scanning when the Quick Menu is displayed. Either select an icon from the Quick Menu and finish the process, or close the Quick Menu before you perform the next scan.
- Do not move, delete, or rename scanned images using other applications while the Quick Menu is displayed.

**HINT**
- Clicking ![description](原理) displays the description of an application. Placing the mouse cursor over the icon of another application displays the description of the application.
- Performing a scan while an application that can be automatically linked with is active automatically starts the linkage between ScanSnap Manager and the application.

For details, refer to the Advanced Operation Guide.
When scanning small size documents such as business cards and postcards with the ScanSnap, you can insert two documents at a time or you can insert the next document while the current document is being scanned. These scanning methods are referred to as dual scans. Documents can be inserted in the following two methods:

- Inserting two documents at a time in the ScanSnap

- Inserting the next document while the current document is being scanned

ATTENTION

- When you select an option other than [Automatic detection] for [Paper size] in the [Paper] tab of the "ScanSnap Setup Window" (page 44), the dual scan function is disabled.

- Use a dual scan to scan a document within the following ranges. If one of the following ranges is exceeded, a length error occurs and part of the document may not appear in the scanned image.
  - Maximum scanning length: 863 mm (34 in.) (355.6 mm (14 in.) when [Excellent] is specified for [Image Quality] in the [Scanning] tab of the "ScanSnap Setup Window" (page 44))
  - Maximum number of documents for scanning: 20 sheets

- When you continue scanning by inserting the next document while the current document is being scanned, the [Scan/Stop] button flashes more quickly if the scanning length exceeds 650 mm (26
in.). If this occurs, wait until scanning is complete without continuing to insert more documents. After scanning is complete, insert the next document. The next scan is started automatically.

1. Open the feed guide of the ScanSnap.

![Feed Guide](image)

**HINT**
- If you want the document to be ejected from the front of the ScanSnap or when there is not enough space where the document exits the ScanSnap, open the output guide.
  For details about documents that can be scanned with the output guide open, refer to "Documents to Scan" (page 63).

![Output Guide](image)

- How the document is ejected differs as below depending on whether the output guide is open or closed.
  - When the output guide is closed
    ![Output Guide Closed](image)
  - When the output guide is open
    ![Output Guide Open](image)

uclear The [Scan/Stop] button flashes in blue. The button returns to being lit normally when document scanning is enabled.

In addition, the ScanSnap Manager icon in the Dock changes from 📈 to 📈.

2. Insert the document straight into the feeding section of the ScanSnap, with the scanning side facing up.

Insert each document in the center of the left or right half of the feeding section.
ATTENTION
When inserting the documents, insert them at least 10 mm (0.39 in.) apart from each other. If the space between the documents is less than 10 mm (0.39 in.), the scanned images may not be cropped correctly.

The document is pulled in until it is set inside the ScanSnap.

ATTENTION
- When you perform scanning with the output guide closed, leave enough space at the back of the ScanSnap to allow the document to be completely ejected. In addition, when you scan long page documents, hold the scanned documents with your hands to prevent them from falling off the unit where the ScanSnap is placed on.
  Make sure that the area where the document exits the scanner is clear of any obstacles. Otherwise, paper jam may occur.

- If you scan the following documents with the output guide open, a paper jam may occur and damage the documents. Scan the following documents with the output guide closed.
  - Thick paper (80 g/m² [20 lb] or heavier)
  - Postcards
  - Business cards

3. Press the [Scan/Stop] button on the ScanSnap to start scanning.

ATTENTION
Do not perform the following operations during scanning. Doing so will stop scanning.
- Connect or disconnect the ScanSnap and other USB devices.
- Close the feed guide.
Switch users.
Allow the computer to enter sleep mode.

- The [Scan/Stop] button on the ScanSnap flashes in blue while the documents are being scanned.

The [ScanSnap Manager - Image scanning and file saving] window appears.

**HINT**
When the [ScanSnap Manager - Image scanning and file saving] window is maximized, multiple scanned images are displayed in the preview area. When you use a dual scan, it is recommended that you maximize the [ScanSnap Manager - Image scanning and file saving] window to check that scanned images are created correctly while scanning documents.

- When scanning is complete, the [ScanSnap Manager - Image scanning and file saving] window displays a scanning standby status.
4. Press the [Scan/Stop] button on the ScanSnap to finish scanning.
   ➔ The Quick Menu appears.

5. In the Quick Menu, click the icon of the application to link with ScanSnap Manager.
   For details about linking the following applications with ScanSnap Manager, refer to "Useful Usages" (page 83).
   - ScanSnap Organizer
   - CardMinder
The selected application starts up. For details, refer to the Advanced Operation Guide.

**ATTENTION**
- You cannot start scanning when the Quick Menu is displayed. Either select an icon from the Quick Menu and finish the process, or close the Quick Menu before you perform the next scan.
- Do not move, delete, or rename scanned images using other applications while the Quick Menu is displayed.

**HINT**
- Clicking displays the description of an application. Placing the mouse cursor over the icon of another application displays the description of the application.
- Performing a scan while an application that can be automatically linked with is active automatically starts the linkage between ScanSnap Manager and the application.

For details, refer to the Advanced Operation Guide.
Scanning Documents Larger Than A4 or Letter Size (by Directly Inserting Them in the ScanSnap)

By folding an A3, B4, or Double Letter size document in half and scanning each side continuously, the scanned images of both sides are automatically merged and saved as a single image. For details about documents that can be scanned, refer to "Documents to Scan" (page 63).

**ATTENTION**

- Scanned images are automatically merged only when there is text, diagram, or a table on the fold line of the folded document.
  - When scanned images are automatically merged

![Diagram of automatically merged images]

- When scanned images are not automatically merged

![Diagram of non-automatically merged images]

- After a document is scanned, if the scanned images cannot be merged automatically, you can use ScanSnap Page Merger to merge the scanned images. For details, refer to the ScanSnap Manager Help.

- For a document that will have scanned images which are merged automatically, you can use the optional Carrier Sheet to scan the document and merge the scanned images automatically. For details, refer to "Scanning Documents Larger Than A4 or Letter Size (with the Carrier Sheet)" (page 90).

- If scanned images are unexpectedly merged, clear the [Merge both side images] checkbox on the [Scanning mode option] window, and then scan the document again. To open the [Scanning mode option] window, click the [Option] button in the [Scanning] tab of the "ScanSnap Setup Window" (page 44).
1. Open the feed guide of the ScanSnap.

![Feed Guide]

The [Scan/Stop] button flashes in blue. The button returns to being lit normally when document scanning is enabled. In addition, the ScanSnap Manager icon in the Dock changes from 🔄 to 🔄.

2. Fold the document in half so that the sides to be scanned are facing out.

ATTENTION
Fold the long side of the document in half. If the left and right areas of the folded document are different in size from each other, the scanned images may not be merged automatically.

3. Insert the document straight into the feeding section of the ScanSnap, with the scanning side facing up.

The document is pulled in until it is set inside the ScanSnap.
4. Press the [Scan/Stop] button on the ScanSnap to start scanning.
   ⇒ The [Scan/Stop] button on the ScanSnap flashes in blue and the [ScanSnap Manager - Image scanning and file saving] window appears while the document is being scanned. When scanning is complete, the scanned image of the scanning side is displayed in the preview area.

5. Turn over the document and insert it as described in step 3.
   ATTENTION
   Make sure to scan the front and back sides of the document folded in half consecutively.
   ⇒ Scanning starts automatically.

   HINT
   Repeat steps 2 to 5 to continue scanning more A3, B4, or Double Letter size documents. You can also continue scanning documents smaller than A4 or Letter size.
   For details about scanning a document, refer to "Scanning a Document" (page 17).

6. Press the [Scan/Stop] button on the ScanSnap to finish scanning.
   ⇒ The Quick Menu appears.
7. In the Quick Menu, click the icon of the application to link with ScanSnap Manager.

When you select ☐, you can manage scanned images by folder with ScanSnap Organizer.

For details, refer to "Managing Paper Documents by Folder on a Computer" (page 84).

The selected application starts up. For details, refer to the Advanced Operation Guide.

**ATTENTION**

- You cannot start scanning when the Quick Menu is displayed. Either select an icon from the Quick Menu and finish the process, or close the Quick Menu before you perform the next scan.
- Do not move, delete, or rename scanned images using other applications while the Quick Menu is displayed.

**HINT**

- Clicking ☐ displays the description of an application. Placing the mouse cursor over the icon of another application displays the description of the application.
- Performing a scan while an application that can be automatically linked with is active automatically starts the linkage between ScanSnap Manager and the application.

For details, refer to the Advanced Operation Guide.
ScanSnap Overview

This section provides an overview that you should be aware of before operating ScanSnap.

- "Parts and Functions" (page 33)
- "Charging the Battery" (page 36)
- "System Requirements" (page 38)
- "Overview of the Software Related to the ScanSnap" (page 39)
- "How to Install the Software" (page 40)
- "ScanSnap Manager Icon" (page 41)
- "ScanSnap Manager Menu" (page 42)
- "ScanSnap Setup Window" (page 44)
- "Turning the ScanSnap On or Off" (page 45)
- "Connecting the ScanSnap via Wireless LAN" (page 52)
- "Documents to Scan" (page 63)
Parts and Functions

This section explains the names and functions of the ScanSnap parts.

**Front**

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Feed guide (*1)</td>
<td>Open it to use the ScanSnap. Opening it turns on the ScanSnap. Then, you can place a document on it to insert the document.</td>
</tr>
<tr>
<td>2</td>
<td>Output guide</td>
<td>Open it to eject documents from the front of the ScanSnap. Select an ejection method depending on the document type you are scanning. For details about documents that can be scanned with the ScanSnap, refer to “Documents to Scan” (page 63).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- When the output guide is closed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- When the output guide is open</td>
</tr>
</tbody>
</table>
### Parts and Functions

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Top cover</td>
<td>Open it to remove jammed documents or clean the inside of the ScanSnap. For details about how to clean the inside of the ScanSnap, refer to &quot;Cleaning the Inside of the ScanSnap&quot; (page 109).</td>
</tr>
</tbody>
</table>
| 4   | [Scan/Stop] button (*1)     | Press this button to start or finish scanning. Indicates the status of the ScanSnap as follows:  
  Blue (lit): Ready  
  Blue (flashing): Scanning  
  Orange (flashing): Error |
| 5   | Battery indicator           | Indicates the remaining battery power and battery charging status.  
  **When the ScanSnap is turned on**  
  Blue (lit): Fully charged  
  Orange (lit): Charging  
  Orange (flashing): Low battery  
  **When the ScanSnap is turned off**  
  Orange (lit): Charging |
| 6   | Wi-Fi indicator             | Indicates the status of the ScanSnap connected via wireless LAN as follows:  
  Blue (lit): Connected (Access Point Connect mode)  
  Blue (flashing): Standby  
  Green (lit): Connected (Direct Connect mode)  
  Orange (lit): Not Connectable or waiting for connection in Direct Connect mode  
  Orange (flashing): Not Connectable (WPS error) |
| 7   | Feeding section             | Insert the document here to load.                                                                                                         |

*1: When the ScanSnap has turned off automatically because of the automatic power off function, either press the [Scan/Stop] button (this will not start scanning), or close the feed guide, then open it again to turn the ScanSnap back on.

For details, refer to "Automatic Power OFF" (page 50).

### Side

![Side View Diagram]

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Tape seal</td>
<td>Remove this tape seal after installing the software.</td>
</tr>
<tr>
<td>No.</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----</td>
<td>---------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>9</td>
<td>USB connector</td>
<td>Used to connect a USB cable.</td>
</tr>
</tbody>
</table>

**Back**

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>WPS button</td>
<td>Press this button to connect to a WPS compatible device by using the push button method.</td>
</tr>
<tr>
<td>11</td>
<td>Wi-Fi switch</td>
<td>Turn this switch on to connect the ScanSnap via wireless LAN.</td>
</tr>
</tbody>
</table>
Charging the Battery

The battery of the ScanSnap can be charged by connecting the ScanSnap and the computer with the supplied USB cable.

Charge the ScanSnap’s battery in the following procedure.

**ATTENTION**

- The ScanSnap is powered and charged through a USB port on a computer. Use the USB port that provides a power supply of 500 mA to charge the battery.
- Use the supplied USB cable or the optional USB power adapter to charge the battery.
- Charge the battery in proper air temperature conditions (5 to 35 degrees C/41 to 95 degrees F).
- Do not charge the battery in the following cases:
  - The shape of the USB cable plug was once deformed.
  - The USB cable is damaged.
  - Foreign objects get on the plugs of the USB cable and the USB connector which is on the ScanSnap.
- Do not charge the battery in the following environments:
  - Places which are subject to high humidity, dust, or vibration
  - Places near conventional phones, televisions, or radios
- Check that the ScanSnap does not get wet before charging.
- The battery can be charged while the ScanSnap is being used. Although the following symptoms may occur during a charge, it does not affect the ScanSnap in any way.
  - It takes time until charging completes.
  - The remaining battery power is reduced and charging is not completed.
  - The ScanSnap is automatically turned off during a scan.
- The battery reaches the end of its life after 300 to 500 times of charges and discharges. The battery life varies depending on the conditions that the ScanSnap is used in
- The battery naturally discharges over time even if it is not used.
- When you use the ScanSnap in low temperatures, the charged battery may run out quickly.

1. Connect the USB cable to the USB connector on the ScanSnap and the USB port on the computer.
The battery indicator lights up in orange. When charging completes, the battery indicator turns off.

HINT
You can use the optional USB power adapter to charge the battery in a shorter time.
System Requirements

The ScanSnap has the following system requirements.
For the latest information on requirements, please visit the ScanSnap Support Site at:
http://scansnap.fujitsu.com/g-support/en/

<table>
<thead>
<tr>
<th>Operating system (*1)</th>
<th>macOS High Sierra v10.13 (*2)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>macOS Sierra v10.12.1 or later (*2)</td>
</tr>
<tr>
<td></td>
<td>OS X El Capitan v10.11</td>
</tr>
<tr>
<td>CPU</td>
<td>Intel® Core™ i5 2.5 GHz or higher</td>
</tr>
<tr>
<td>Memory</td>
<td>4 GB or more</td>
</tr>
<tr>
<td>Display resolution</td>
<td>1024 × 768 pixels or higher</td>
</tr>
<tr>
<td>Disk space</td>
<td>Free space required to install the software related to the ScanSnap is as follows: (*3)</td>
</tr>
<tr>
<td></td>
<td>● ScanSnap Manager: 640 MB</td>
</tr>
<tr>
<td></td>
<td>● ScanSnap Organizer: 95 MB</td>
</tr>
<tr>
<td></td>
<td>● CardMinder: 600 MB</td>
</tr>
<tr>
<td></td>
<td>● ABBYY FineReader for ScanSnap: 980 MB</td>
</tr>
<tr>
<td></td>
<td>● ScanSnap Online Update: 20 MB</td>
</tr>
<tr>
<td></td>
<td>● OCR Pack (*4)</td>
</tr>
<tr>
<td></td>
<td>● ScanSnap iX100 Basic Operation Guide: 100 MB</td>
</tr>
<tr>
<td>USB port</td>
<td>USB 3.0 (*5)/USB 2.0/USB 1.1</td>
</tr>
</tbody>
</table>

*1: Updating Mac OS to the latest version is recommended.
*2: ABBYY FineReader for ScanSnap 5.0 is not supported.
*3: To save scanned images, more free space is required.
   For details about estimated image data size, refer to the ScanSnap Manager Help.
*4: By installing the OCR Pack, you can add extra languages to recognize text.
   For the amount of free space required to install the OCR Pack, refer to the following:
*5: When the ScanSnap is connected to a USB 3.0 port, the port operates as a USB 2.0 port.

ATTENTION

● If the system requirements above are not satisfied, the ScanSnap may not operate.
● If a USB port on the keyboard or on the monitor is in use, the ScanSnap may not operate.
● When using a commercially available USB hub, use a type that is powered from an electrical power supply (and that comes with an adapter).
● Scanning speed decreases in the following cases:
  - The CPU or the memory does not meet the recommended specifications.
  - The version of the USB port or the USB hub is USB 1.1.
● To scan a document, a disk space that is approximately three times larger than the size of the file to be saved is required.
Overview of the Software Related to the ScanSnap

This section gives an overview of each bundled software and their functions. You can edit, manage, and arrange the scanned image by using the following software:

**ScanSnap Manager**
- This scanner driver is required to scan documents with the ScanSnap. Scanned images can be saved as PDF or JPEG files to a computer.
- You need to have ScanSnap Connect Application installed on your mobile device to save PDF or JPEG files to your mobile device.
- You can download ScanSnap Connect Application for your mobile device from its application market.

**ScanSnap Organizer**
- You can use this application to display image data (PDF or JPEG files) in a list, create folders, and arrange files as you like.

**CardMinder**
- You can use this application to efficiently digitalize a large number of business cards.
- Text recognition can be performed on business cards and you can create a database to facilitate card data management and searches. Data in the database can be printed and linked with various applications. The data can be also shared with PIM (Personal Information Manager), such as Contacts.

**ABBYY FineReader for ScanSnap**
- This application can perform text recognition on the scanned images using OCR (Optical Character Recognition) to convert the image data to Word, Excel, or PowerPoint files that can be edited.

**ScanSnap Online Update**
- This application checks whether the latest updates or software programs are available on the download server. When the latest updates or software programs are available, you can automatically apply updates or download and install the software programs manually.

**Evernote for Mac**
- You can easily save files in Evernote using the ScanSnap.

**Dropbox for Mac**
- You can easily save files to your Dropbox folder using the ScanSnap.
How to Install the Software

When you insert the Setup DVD-ROM into the DVD-ROM drive on your computer, the [ScanSnap] window appears.

**ATTENTION**

- Do not connect the ScanSnap to the computer before installing the software. Doing so may cause the ScanSnap not to be recognized by the computer. In that case, install the software, and then reconnect the ScanSnap to the computer.
- If a DVD-ROM drive is not available, the installers for the software programs can be downloaded from the following web page.
  
  http://scansnap.fujitsu.com/g-support/en/

The functions of each button in the [ScanSnap] window are as follows.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ScanSnap</td>
<td>Starts installing software.</td>
</tr>
<tr>
<td>Other Software</td>
<td>Displays the [Other Software] window. From this window, you can access the download web pages of the software programs.</td>
</tr>
<tr>
<td>Readme</td>
<td>Displays the Readme file.</td>
</tr>
<tr>
<td>Manuals</td>
<td>The [Manuals] window appears. You can refer to Safety Precautions, Getting Started, the Basic Operation Guide (this manual), and the Advanced Operation Guide.</td>
</tr>
</tbody>
</table>
ScanSnap Manager Icon

When ScanSnap Manager is running, the ScanSnap Manager icon is displayed in the Dock. The ScanSnap Manager icon indicates whether or not ScanSnap Manager is successfully communicating with the ScanSnap. The appearance of the icon changes according to the communication status as shown below.

This manual assumes that the ScanSnap is connected to a computer with a USB cable.

<table>
<thead>
<tr>
<th>Communication Status</th>
<th>ScanSnap Manager Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communicating</td>
<td>![Icon USB] When the ScanSnap is connected to a computer with a USB cable</td>
</tr>
<tr>
<td></td>
<td>![Icon Wireless] When the ScanSnap is connected to a computer via wireless LAN</td>
</tr>
<tr>
<td>Not communicating</td>
<td>![Icon Mobile Wireless] When the ScanSnap is connected to a mobile device via wireless LAN</td>
</tr>
</tbody>
</table>

**HINT**

Turn the ScanSnap on to begin communication between ScanSnap Manager and the ScanSnap. For details about how to turn on the ScanSnap, refer to “Turning the ScanSnap On” (page 46).

You can display the menu for scanning documents and ScanSnap Manager settings from the ScanSnap Manager icon.

- Clicking while holding down the [control] key on the keyboard
  Displays the "ScanSnap Manager Menu" (page 42).
- Clicking
  Displays the Profile menu.
  For details, refer to the Advanced Operation Guide.
### ScanSnap Manager Menu

This menu appears when you click the ScanSnap Manager icon in the Dock while holding down the [control] key on the keyboard.

![ScanSnap Manager Menu Image]

**Item** | **Function**
---|---
Scan | Scans the document inserted in the ScanSnap. Follows the settings configured in [Settings].
Settings | Displays the "ScanSnap Setup Window" (page 44). You can configure the scan settings in this window.
Profile | Displays the Profile menu. You cannot select this when the [Use Quick Menu] checkbox is selected in the ScanSnap setup window.
Profile Management | Displays the [ScanSnap Manager - Profile Management] window. You cannot select [Profile Management] when the [Use Quick Menu] checkbox is selected in the ScanSnap setup window. For details, refer to the Advanced Operation Guide.
Connect by Wi-Fi | Displays the [ScanSnap Manager - Connect by Wi-Fi] window. You can connect the ScanSnap to a computer via wireless LAN. This cannot be selected when the ScanSnap is connected to a computer via a USB cable. For details, refer to "Connecting the ScanSnap via Wireless LAN" (page 52).
Preferences | Displays the [ScanSnap Manager - Preferences] window.
<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>Displays the following menu:</td>
</tr>
<tr>
<td></td>
<td>- Help</td>
</tr>
<tr>
<td></td>
<td>　Opens the ScanSnap Manager Help.</td>
</tr>
<tr>
<td></td>
<td>- Troubleshooting</td>
</tr>
<tr>
<td></td>
<td>　Displays [Troubleshooting] in the ScanSnap Manager Help.</td>
</tr>
<tr>
<td></td>
<td>- ScanSnap Portal Site</td>
</tr>
<tr>
<td></td>
<td>　Opens the ScanSnap global homepage (<a href="http://scansnap.fujitsu.com">http://scansnap.fujitsu.com</a>).</td>
</tr>
<tr>
<td></td>
<td>- About ScanSnap Manager</td>
</tr>
<tr>
<td></td>
<td>　Displays the [ScanSnap Manager - Version Information] window.</td>
</tr>
<tr>
<td></td>
<td>- ScanSnap information</td>
</tr>
<tr>
<td></td>
<td>　Displays the [ScanSnap Manager - Scanner and driver information] window.</td>
</tr>
<tr>
<td></td>
<td>- Online Update</td>
</tr>
<tr>
<td></td>
<td>　 Starts the ScanSnap Online Update.</td>
</tr>
<tr>
<td></td>
<td>　For details, refer to &quot;Updating the Software&quot; (page 114).</td>
</tr>
<tr>
<td>To establish connection</td>
<td>Displayed when ScanSnap Manager is not communicating with the ScanSnap correctly.</td>
</tr>
<tr>
<td>Battery</td>
<td>You can check the remaining battery power and battery charging status. This is displayed when the ScanSnap is connected to the computer. When you click this, the [ScanSnap Manager - Scanner and driver information] window appears.</td>
</tr>
<tr>
<td>Options</td>
<td>Displays the following menu:</td>
</tr>
<tr>
<td></td>
<td>- Keep in Dock</td>
</tr>
<tr>
<td></td>
<td>　Adds the ScanSnap Manager icon to the Dock.</td>
</tr>
<tr>
<td></td>
<td>- Open at Login</td>
</tr>
<tr>
<td></td>
<td>　 Automatically launches ScanSnap Manager when the computer is started up or logged in.</td>
</tr>
<tr>
<td></td>
<td>- Show in Finder</td>
</tr>
<tr>
<td></td>
<td>　Displays the contents of the [ScanSnap] folder by using the Finder.</td>
</tr>
<tr>
<td>Show All Windows</td>
<td>Shows all windows from ScanSnap Manager in thumbnails.</td>
</tr>
<tr>
<td>Hide/Show</td>
<td>Hides or shows all windows from ScanSnap Manager.</td>
</tr>
<tr>
<td>Quit</td>
<td>Quits ScanSnap Manager.</td>
</tr>
</tbody>
</table>
ScanSnap Setup Window

When you click the ScanSnap Manager icon while holding down the [control] key on the keyboard, and then select [Settings] from the “ScanSnap Manager Menu” (page 42), the following ScanSnap setup window appears.

In the ScanSnap setup window, you can use the [Use Quick Menu] checkbox to specify whether or not to use the Quick Menu. You can also use the profile buttons and detail setting tabs to specify scan settings according to your scanning needs.

For details, refer to the ScanSnap Manager Help.
Turning the ScanSnap On or Off

This section explains how to turn the ScanSnap on or off and how to check the remaining battery power.

- "Turning the ScanSnap On" (page 46)
- "Turning the ScanSnap Off" (page 48)
- "Sleep Mode" (page 49)
- "Automatic Power OFF" (page 50)
- "Checking the Remaining Battery Power" (page 51)
Turning the ScanSnap On

1. Turn on the computer.

   **HINT**
   If you connect the ScanSnap and a mobile device via a wireless LAN and then scan a document, you do not have to turn on the computer.

   - The computer starts up and the ScanSnap Manager icon  
     appears in the Dock.

   **HINT**
   - If the ScanSnap Manager icon  is not displayed in the Dock, click [Applications] from the sidebar in Finder, click [ScanSnap], and then double-click [ScanSnap Manager].
   - If ScanSnap Manager does not automatically start when you log in to the computer, display the [System Preferences] window and select [Users & Groups] → [Current User] → [Login Items] → [+] → [ScanSnap] → [ScanSnap Manager].

2. Open the feed guide of the ScanSnap to turn the power on.

   **Example: When a USB Cable is Used for Connection**

   - The [Scan/Stop] button flashes in blue. The button returns to being lit normally when document scanning is enabled.

   In addition, the ScanSnap Manager icon in the Dock changes from  to  .

   **ATTENTION**
   With some computers, the initialization of the ScanSnap may be performed several times when the computer is started up.
HINT

- It may take more time for the ScanSnap Manager icon in the Dock to change to depending on computer performance, operating environment, or loading, for example, when many software programs are running at the same time.
- When the ScanSnap is turned on, a notification window notifies you of the ScanSnap's communication status.

To disable notifications of the ScanSnap's communication status, change the setting in the following procedure:

1. Click the ScanSnap Manager icon in the Dock while holding down the [control] key on the keyboard, and then select [Preferences] from the “ScanSnap Manager Menu” (page 42).
   - The [ScanSnap Manager - Preferences] window appears.
2. Clear the [Notify of the communication status] checkbox in the [Status Display] list.
Turning the ScanSnap Off

1. Close the feed guide.

Example: When a USB Cable is Used for Connection

⇒ The [Scan/Stop] button turns off.

In addition, the ScanSnap Manager icon in the Dock changes from ☰ to ☰.

**ATTENTION**
If moving the ScanSnap, first turn the power off and remove all cables.

**HINT**
- If the Wi-Fi switch is off, the power of the ScanSnap and the computer operate together. If you keep the ScanSnap connected to the computer, you do not have to worry about turning the power ON/OFF.
- With some computers, it may take 2 to 3 minutes until the light of the [Scan] button goes out after the computer is turned off.
- When the ScanSnap is turned off, a notification window notifies you of the ScanSnap's communication status.
  
  To disable notifications of the ScanSnap's communication status, change the setting in the following procedure:

1. Click the ScanSnap Manager icon ☰ in the Dock while holding down the [control] key on the keyboard, and then select [Preferences] from the "ScanSnap Manager Menu" (page 42).
  
  ⇒ The [ScanSnap Manager - Preferences] window appears.

2. Clear the [Notify of the communication status] checkbox in the [Status Display] list.
Sleep Mode

When the ScanSnap is on and has not been used for one minute, it enters sleep (power saving) mode.
Automatic Power OFF

When the ScanSnap connected with a USB cable is turned on and left unused for the specified time (default is "4 hours"), it will turn itself off automatically.

When the ScanSnap powered by a battery is turned on and left unused for the specified time (default is "5 minutes"), it will turn itself off automatically.

To turn the ScanSnap back on, perform one of the following operations:

- Press the [Scan/Stop] button on the ScanSnap
- Close the feed guide and open it again

**HINT**

- To continue using the ScanSnap, reset the time until auto power-off by performing one of the following:
  - Load a document in the ScanSnap
  - Press the [Scan/Stop] button on the ScanSnap
  - Close the feed guide and open it again
- You can change the time of the ScanSnap to turn off automatically or change the setting so that it will not turn off automatically. Set according to the following procedures:

  1. Click the ScanSnap Manager icon \(\text{[ScanSnap Manager icon]}\) in the Dock while holding down the [control] key on the keyboard, and then select [Preferences] from the "ScanSnap Manager Menu" (page 42).

  ! [ScanSnap Manager - Preferences window](image)

  - The [ScanSnap Manager - Preferences] window appears.

  2. In the [Power] list, change the settings for [Power setting] based on how it is connected.

- A notification window notifies you in the following cases:
  - When a USB cable is used for connection, the ScanSnap will turn off automatically five minutes later.
  - When the ScanSnap is powered by the battery, the ScanSnap has turned off automatically.
Checking the Remaining Battery Power

The ScanSnap has a battery.

To check the remaining battery power, click the ScanSnap Manager icon in the Dock while holding down the [control] key on the keyboard, and check [Battery] in the "ScanSnap Manager Menu" (page 42).

HINT

- The remaining battery power can be checked also in the [ScanSnap Manager - Scanner and driver information] window.
  
  To open the [ScanSnap Manager - Scanner and driver information] window, select [ScanSnap information] in the "ScanSnap Manager Menu" (page 42).

- A notification window notifies you in the following cases:
  - The remaining battery power is 10% or less.
  - No battery power remains and the ScanSnap is turned off.
By connecting the ScanSnap to a computer or a mobile device via wireless LAN, you can scan documents.

Select one of the following wireless modes to connect the ScanSnap to the computer or mobile device.

- **Access Point Connect mode**
  When a wireless LAN environment has already been configured, the ScanSnap and the computer or mobile device are connected via a wireless access point.

- **Direct Connect mode**
  When a wireless LAN environment has not been configured, the ScanSnap and the computer or mobile device are connected directly via wireless LAN.

The wireless mode automatically switches to the mode in accordance with the wireless LAN environment in which the ScanSnap is used.

When the ScanSnap is turned on, it is connected to the wireless access point that was set in the ScanSnap Wireless Setup Tool. If no wireless access point is detected, the mode is switched to the Direct Connect mode.

**HINT**

- When the wireless access point that was set in the ScanSnap Wireless Setup Tool is detected, even if the wireless access point is not connectable, the mode is not switched from the Access Point Connect mode to the Direct Connect mode.
  To switch the mode to the Direct Connect mode, turn off the ScanSnap and then turn it on again in an environment in which no wireless access point is detected.

- Even if the wireless access point that was set in the ScanSnap Wireless Setup Tool is detected after the mode is switched to the Direct Connect mode, the mode is still not switched to the Access Point Connect mode.
  To connect the ScanSnap in Access Point Connect mode, turn off the ScanSnap and then turn it on again.

For details about how to switch the wireless mode and how to set the wireless mode, refer to the ScanSnap Wireless Setup Tool Help.

- "Preparation" (page 53)
- "Setting a Wireless LAN Using the ScanSnap Wireless Setup Tool" (page 54)
- "Connecting a Computer in Access Point Connect Mode" (page 55)
- "Connecting a Mobile Device in Access Point Connect Mode" (page 57)
- "Connecting a Computer in Direct Connect Mode" (page 58)
- "Connecting a Mobile Device in Direct Connect Mode" (page 60)
- "Reconnecting to a Wireless Access Point Using the ScanSnap WPS Button" (page 61)
Preparation

To connect the ScanSnap via wireless LAN, prepare the following:

- An environment in which a wireless LAN is available
  
  To connect the ScanSnap and a computer or a mobile device in Access Point Connect mode, prepare the wireless LAN environment.
  
  When connecting the ScanSnap to a wireless access point, you may need information such as an SSID (network name) and a security key (password).
  
  For details, refer to the manual for the wireless access point.

ATTENTION

Do not place the following within 100 mm (3.9 in.) of the ScanSnap, or near your wireless access point.

- Obstacles that block radio waves (such as walls and metal plates)
- Devices that may cause signal interference (such as microwaves and cordless phones) and wireless devices

- ScanSnap Connect Application
  
  To connect the ScanSnap and a mobile device, you need to install ScanSnap Connect Application on your mobile device.
  
  Download ScanSnap Connect Application for the mobile device from the following application stores:
  
  - App Store
  - Google Play
  - Amazon Appstore
Setting a Wireless LAN Using the ScanSnap Wireless Setup Tool

The ScanSnap Wireless Setup Tool is an application to configure the wireless settings required for connecting your ScanSnap via wireless LAN in a wizard format. The ScanSnap Wireless Setup Tool can be used to configure and check the following wireless LAN settings and connection.

- Connecting the ScanSnap to a wireless access point
- Registering the computer that will be connected to the ScanSnap via wireless LAN
- Setting the IP address, name, and password for the ScanSnap
- Checking the connection between the ScanSnap and the computer
- Checking the connection between the ScanSnap and the mobile device

Follow the procedure below to start the ScanSnap Wireless Setup Tool and configure the wireless settings.

1. **From the sidebar in Finder, select [Applications] → [ScanSnap], and then double-click [ScanSnap Wireless Setup Tool].**
   - The ScanSnap Wireless Setup Tool will start running.

2. Click the [Wireless Network Setup Wizard] button in the main menu.
   - The Wireless Network Setup Wizard appears.

3. **Follow the instructions in the Wireless Network Setup Wizard to configure the wireless settings.**
   - Configure and check the wireless settings based on the wireless LAN environment in which the ScanSnap is used.

**HINT**
- For details and operation of ScanSnap Wireless Setup Tool, refer to the ScanSnap Wireless Setup Tool Help.
- The ScanSnap Wireless Setup Tool is also started up when the ScanSnap software is installed.
Connecting a Computer in Access Point Connect Mode

By using the ScanSnap Wireless Setup Tool Wizard, you can configure and check the connection between the ScanSnap and a computer.

For details, refer to "Setting a Wireless LAN Using the ScanSnap Wireless Setup Tool" (page 54).

The following explains how to connect the ScanSnap and a computer when the wireless settings have already been configured by using the ScanSnap Wireless Setup Tool Wizard.

1. **Disconnect the USB cable connecting the ScanSnap to the computer.**

   **ATTENTION**
   
   If the ScanSnap Manager icon is , exit ScanSnap Connect Application on the mobile device.

   The ScanSnap is automatically connected to a computer via wireless LAN and the ScanSnap Manager icon changes to .

   If the icon does not change, go to step 2.

   **HINT**
   
   ● If the [Connect automatically to previous ScanSnap by Wi-Fi] checkbox is selected and the previously connected ScanSnap is available for the connection, the computer is connected to the ScanSnap automatically.
   
   ● The computer can be connected to only one ScanSnap.
   
   ● Only one computer can be connected to the ScanSnap via wireless LAN.
   
   ● When you automatically connect a computer and the ScanSnap that had been connected via wireless LAN before, if the password for the ScanSnap to be connected is changed, a notification window notifies you of the status.

2. **Click the ScanSnap Manager icon in the Dock while holding down the [control] key on the keyboard, and then select [Connect by Wi-Fi] from the "ScanSnap Manager Menu" (page 42).**

   The [ScanSnap Manager - Connect by Wi-Fi] window appears.

3. **From the list of the ScanSnap units to be connected, select the ScanSnap that you want to connect, and click the [Connect] button.**

   **ATTENTION**
   
   ● If the [ScanSnap Manager - Enter Destination Password] window appears, enter the password to connect.

   The default password is the last four digits of the ScanSnap serial number.

   The password can be changed with the ScanSnap Wireless Setup Tool. For details, refer to the ScanSnap Wireless Setup Tool Help.

   ● If the intended ScanSnap for connection does not appear in the list of the ScanSnap units to be connected, refer to the ScanSnap Manager Help.
The ScanSnap is connected to a computer via wireless LAN and the ScanSnap Manager icon changes to 📈.

HINT
When the ScanSnap and a computer are connected via wireless LAN, a notification window notifies you of the communication status.
Connecting a Mobile Device in Access Point Connect Mode

By using the ScanSnap Wireless Setup Tool Wizard, you can configure and check the connection between the ScanSnap and a mobile device.

For details, refer to "Setting a Wireless LAN Using the ScanSnap Wireless Setup Tool" (page 54).

The following explains how to connect the ScanSnap and a mobile device when the wireless settings have already been configured by using the ScanSnap Wireless Setup Tool Wizard.

1. **Start ScanSnap Connect Application on your mobile device.**
   - The mobile device will automatically be connected to an available ScanSnap on the same network.

   **HINT**
   - If more than one available ScanSnap is detected, or if ScanSnap Connect Application is set not to connect a mobile device to a ScanSnap automatically, then tap the ScanSnap that you want by name, in order to connect to the mobile device, under [ScanSnap] on the [Connect to] screen. For details, refer to the Basic Operation Guide (Mobile Connection) for your mobile device.
   - A notification window notifies you in the following cases:
     - When the ScanSnap and the mobile device are connected via wireless LAN, and the communication with ScanSnap Manager is disconnected
     - When you log into the computer which is connected to the ScanSnap with the ScanSnap and the mobile device already connected via wireless LAN
Connecting a Computer in Direct Connect Mode

By using the ScanSnap Wireless Setup Tool Wizard, you can configure and check the connection between the ScanSnap and a computer.

For details, refer to "Setting a Wireless LAN Using the ScanSnap Wireless Setup Tool" (page 54).

The following explains how to connect the ScanSnap and a computer when the computer to be connected has already been registered by using the ScanSnap Wireless Setup Tool Wizard.

1. Click in the status menu of the menu bar, and connect the ScanSnap network displayed in the wireless network list.

   The ScanSnap network name (SSID) and the security key are printed on the label attached to the bottom of the scanner.

   **HINT**
   The network name (SSID) and the security key can be checked or changed with the ScanSnap Wireless Setup Tool.

2. Disconnect the USB cable connecting the ScanSnap to the computer.

   **ATTENTION**
   If the ScanSnap Manager icon is , exit ScanSnap Connect Application on the mobile device.

   - The ScanSnap is automatically connected to a computer via wireless LAN and the ScanSnap Manager icon changes to .

   - If the icon does not change, go to step 3.

   **HINT**
   ● If the [Connect automatically to previous ScanSnap by Wi-Fi] checkbox is selected and the previously connected ScanSnap is available for the connection, the computer is connected to the ScanSnap automatically.
   ● The computer can be connected to only one ScanSnap.
   ● Only one computer can be connected to the ScanSnap via wireless LAN.
   ● When you automatically connect a computer and the ScanSnap that had been connected via wireless LAN before, if the password for the ScanSnap to be connected is changed, a notification window notifies you of the status.

3. Click the ScanSnap Manager icon in the Dock while holding down the [control] key on the keyboard, and then select [Connect by Wi-Fi] from the "ScanSnap Manager Menu" (page 42).

   - The [ScanSnap Manager - Connect by Wi-Fi] window appears.
4. From the list of the ScanSnap units to be connected, select the ScanSnap that you want to connect, and click the [Connect] button.

ATTENTION
- If the [ScanSnap Manager - Enter Destination Password] window appears, enter the password to connect.
  The default password is the last four digits of the ScanSnap serial number.
  The password can be changed with the ScanSnap Wireless Setup Tool. For details, refer to the ScanSnap Wireless Setup Tool Help.
- If the intended ScanSnap for connection does not appear in the list of the ScanSnap units to be connected, refer to the ScanSnap Manager Help.

 hintText
The ScanSnap is connected to the computer via a wireless access point and the ScanSnap Manager icon changes to 📦.

HINT
When the ScanSnap and a computer are connected via wireless LAN, a notification window notifies you of the communication status.
Connecting a Mobile Device in Direct Connect Mode

When you connect a mobile device to the ScanSnap in Direct Connect mode, you do not need to configure settings in the ScanSnap Wireless Setup Tool.

For details, refer to the Basic Operation Guide (Mobile Connection).
Reconnecting to a Wireless Access Point Using the ScanSnap WPS Button

If the Wi-Fi indicator lights up or flashes in orange, reconnect the ScanSnap to a WPS compatible wireless access point. The reconnection can be established easily by pressing the WPS button on the ScanSnap.

**ATTENTION**
Perform the following before you connect using the WPS button.

- If the ScanSnap Wireless Setup Tool is running while the ScanSnap is being connected to the computer with a USB cable, exit the ScanSnap Wireless Setup Tool.
- If scanning is currently being performed from ScanSnap Manager or a mobile device, end the scanning operation.

**HINT**
Button names and operating procedures may differ depending on the wireless access point. For details, refer to the manual for your wireless access point.

1. **Turn on the Wi-Fi switch on the back of the ScanSnap.**
   
   ![Wi-Fi Switch](image)

2. **Turn on the ScanSnap.**
   For details, refer to “Turning the ScanSnap On” (page 46).
   ➔ After blinking blue, the Wi-Fi indicator lights up in blue or orange.

3. **Press the WPS button of the wireless access point.**
4. Press and hold (3 seconds or longer) the WPS button on the back of the ScanSnap within 2 minutes after pressing the WPS button of the wireless access point.

The ScanSnap is connected to the wireless access point and the Wi-Fi indicator lights up in blue.

If connection cannot be established, the Wi-Fi indicator blinks or lights up in orange.

ATTENTION
If you cannot connect the ScanSnap to a wireless access point, refer to "Troubleshooting" in the ScanSnap Manager Help.

HINT
For details about the Wi-Fi indicator status, refer to "Parts and Functions" (page 33).
Documents to Scan

This section explains about the conditions for documents that can be loaded directly into the ScanSnap and the conditions for documents that can be scanned using the Carrier Sheet.

- "Documents That Can Be Loaded Directly into the ScanSnap" (page 64)
- "Documents That Can Be Scanned Using the Carrier Sheet" (page 66)
## Documents That Can Be Loaded Directly into the ScanSnap

Conditions for documents that can be loaded directly into the ScanSnap are as follows:

<table>
<thead>
<tr>
<th>Eject method (*1)</th>
<th>With the output guide closed</th>
<th>With the output guide open</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document type</td>
<td>Office paper, postcards, business cards</td>
<td>Plastic cards conforming to the ISO7810 ID-1 type (54 × 86 mm/3.37 × 2.13 in.) (*2)</td>
</tr>
<tr>
<td>Paper weight</td>
<td>52.3 to 209.3 g/m² (14 to 56.1 lb)</td>
<td>When merging scanned images automatically (*3)</td>
</tr>
<tr>
<td></td>
<td>When merging scanned images automatically (*3)</td>
<td>52.3 to 104.7 g/m² (14 to 28 lb)</td>
</tr>
<tr>
<td></td>
<td>Plastic cards</td>
<td>0.76 mm (0.03 in.) or less (embossed cards can be used)</td>
</tr>
<tr>
<td>Paper size</td>
<td>Width</td>
<td>25.4 to 216 mm (1 to 8.5 in.)</td>
</tr>
<tr>
<td></td>
<td>Length</td>
<td>25.4 to 863 mm (1 to 34 in.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● A3 (297 × 420 mm)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● B4 (257 × 364 mm)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Double Letter (11 × 17 in. (279.4 × 432 mm))</td>
</tr>
</tbody>
</table>

*1: For details about the eject methods, refer to "Parts and Functions" (page 33).

*2: A dual scan cannot be used for plastic cards.

*3: Fold in half to scan.

### ATTENTION

- The following types of documents must not be scanned:
  - Documents attached with the metals such as paper clips or staples that can damage the inside of the ScanSnap
    Remove the metals for scanning.
  - Documents on which the ink is still wet
    Wait until the ink dries completely to scan these documents.
  - Documents larger than 216 × 863 (mm)/8.5 × 34 (in.) (width × length)
  - Documents other than paper such as fabric, metal foil and OHP film
- When you scan picture postcards, be aware that the picture side may get damaged. It is the responsibility of the customer to scan picture postcards.
- Be careful of the following when you scan plastic cards:
  - Cards that are bent may not be fed properly.
  - If the surface of the card is dirty with grease marks such as fingerprints, perform scanning after wiping the dirt off.
- Insert the plastic card straight into the feeding section of the ScanSnap. Do not tilt the plastic card when you insert it because the plastic card may not be fed properly.
- When you scan plastic cards with strong luster, some parts of the image may appear lighter or darker than the original.
  
  Example: gold colored credit card
- When you scan an embossed card, insert it in the direction shown below.

- If the embossed characters are not coated in gold or silver and the background color of the card and the color of the embossed characters are similar, it may be difficult for the ScanSnap to recognize embossed characters.

  In which case, performing the following may result in an improvement.

  1. Click the [Option] button in the [Scanning] tab of the "ScanSnap Setup Window" (page 44).

    The [Scanning mode option] window appears.

  2. Select the [Increase text contrast] checkbox.
Documents That Can Be Scanned Using the Carrier Sheet

The optional Carrier Sheet is a sheet designed to transport documents through the ScanSnap. You can scan documents that are larger than A4/Letter size, photographs, and clippings. Conditions for documents that can be scanned using the Carrier Sheet are as follows:

- Do not use a damaged Carrier Sheet. Otherwise, it may damage or cause the ScanSnap to malfunction.
- Be careful not to cut your finger on the edge of the Carrier Sheet.

### Eject method
With the output guide closed

### Document type
Documents that cannot be loaded directly into the ScanSnap

### Paper weight
Up to 52.3 to 209.3 g/m² (14 to 56 lb)

**When scanning documents folded in half:**
Up to 104.7 g/m² (28 lb)

### Paper size
- Carrier Sheet size (216 × 297 mm)
- A3 (297 × 420 mm) (*1)
- A4 (210 × 297 mm)
- A5 (148 × 210 mm)
- A6 (105 × 148 mm)
- B4 (257 × 364 mm) (*1)
- B5 (182 × 257 mm)
- B6 (128 × 182 mm)
- Postcard (100 × 148 mm)
- Business card (90 × 55 mm, 55 × 90 mm)
- Letter (8.5 × 11 in. (216 × 279.4 mm))
- 11 × 17 in. (279.4 × 431.8 mm) (*1)

**Custom size**
- Width: 25.4 to 216 mm (1 to 8.5 in.)
- Length: 25.4 to 297 mm (1 to 11.69 in.)

*1: Fold in half to scan.

### Documents for Which the Carrier Sheet is Recommended for Scanning

It is recommended that you use the Carrier Sheet to scan the following documents.

- Documents written in pencil
  - Because there may be black traces left on the documents, it is recommended that you use the Carrier Sheet to scan such documents.
  - When you scan such documents directly without using a Carrier Sheet, dirt will accumulate on the rollers, which may cause feeding errors. Clean the rollers occasionally.
  - For details about how to perform cleaning, refer to "Cleaning the Inside of the ScanSnap" (page 109).

- Carbonless paper
Because carbonless paper may contain chemicals that can harm the ScanSnap internal rollers, it is recommended that you use the Carrier Sheet to scan such documents.

Make sure to clean the rollers occasionally to maintain the scanner performance when scanning carbonless paper directly without using the Carrier Sheet. For details about how to perform cleaning, refer to "Cleaning the Inside of the ScanSnap" (page 109).

Depending on the type of carbonless paper, the life span of the scanner may be shortened compared to scanning office paper.

- Scanning the following types of documents without using the Carrier Sheet can result in documents being damaged or scanned incorrectly
  - Documents smaller than 25.4 × 25.4 (mm)/1 × 1 (in.) (width × length)
  - Documents whose paper weight is less than 52.3 g/m² (14 lb)
  - Documents with an uneven surface (such as envelopes and paper sheets with attached materials)
  - Wrinkled or curled documents
  - Folded or torn documents
  - Tracing paper
  - Coated paper
  - Photographs (photographic paper)
  - Perforated or punched documents
  - Documents that are not rectangular or square
  - Carbon paper or thermal paper
  - Documents with memo papers or sticky notes attached

ATTENTION

- Using the Carrier Sheet
  Be careful of the following when you use the Carrier Sheet:
  - Do not stain, or cut the end with a black & white pattern. Otherwise, the Carrier Sheet will not be recognized properly.
  - Do not place the Carrier Sheet upside down. Otherwise, a paper jam may occur and damage the Carrier Sheet and the document inside.
  - Do not fold or pull the Carrier Sheet.
  - Paper jams may occur when several small size documents such as photographs and postcards are placed inside the Carrier Sheet to be scanned at once. It is recommended that you scan such documents one at a time.

- Storing the Carrier Sheet
  Be careful of the following when you store the Carrier Sheet:
  - Do not leave your document inside the Carrier Sheet for a long time. Otherwise, the ink on the document may be transferred onto the Carrier Sheet.
  - Do not leave the Carrier Sheet in high temperature places such as under direct sunlight or near a heating apparatus for a long time. Also, do not use the Carrier Sheet in high temperature places. The Carrier Sheet may be deformed.
  - To avoid deformation, store the Carrier Sheet on a flat surface without any weight on it.
What You Can Do with Related Software

This section explains the basic operation procedure of software related to the ScanSnap and gives an overview of its functions.

- "What You Can Do with the ScanSnap Organizer" (page 69)
- "What You Can Do with CardMinder" (page 74)
What You Can Do with the ScanSnap Organizer

ScanSnap Organizer is an application used for displaying, organizing, and managing image data (PDF or JPEG files) scanned with the ScanSnap.

You can use this application to create folders and arrange files for various uses.

Pages of a PDF file can be opened with an associated application to check the scanned image data.

- "Basic Operation Procedure of ScanSnap Organizer" (page 70)
- "Managing Files" (page 71)
- "Using Files" (page 73)
Basic Operation Procedure of ScanSnap Organizer

This section explains the basic operation procedure of ScanSnap Organizer.

1. From the sidebar in Finder, select [Applications] → [ScanSnap Organizer], and then double-click [ScanSnap Organizer] to start up ScanSnap Organizer.

2. Scan documents with the ScanSnap.
   ➡ A list of scanned images is displayed in ScanSnap Organizer.
Managing Files

For details about operations, refer to the ScanSnap Organizer Help.

**Setting a Marked Character String as a Keyword**

Keywords can be set to a PDF file by using the keyword setting function. These keywords can be used when you search for PDF files. When black and white documents that have been marked are scanned by the ScanSnap, the marked character strings are set as keywords for the PDF file.

Mark the characters on a document

"Proposal" can be used as a keyword to search for the file

Scan the document with the ScanSnap

Document

PDF file with a keyword

Recognizing a Character String in a Page to Embed It into the Page

By using text recognition (OCR) software, you can embed character strings into the page of a PDF file scanned by the ScanSnap, and then search the PDF file using the character strings.

OCR recognizes "proposal" as textual information.

"Proposal" can be used as a keyword to search for the file

PDF file
Searching Files

You can search files that are managed in ScanSnap Organizer.
Using Files

For details about operations, refer to the ScanSnap Organizer Help.

**Linking Files with Other Applications**

You can use files with a variety of applications.

**Sending Files by E-mail**

Files can be sent by e-mail.

**Using Files by Syncing with a Mobile Device**

By using the ScanSnap Sync function, an image file scanned by the ScanSnap can be synced automatically with a mobile device and can be used easily anytime or anywhere via a cloud service. The files are organized and managed in the "ScanSnap Sync" folder in ScanSnap Organizer.

**Syncing Files Made up of Images That Were Saved Together ("JPEG (Save together)" Files)**

Using the ScanSnap Sync function allows you to sync "JPEG (Save together)" files between a mobile device and ScanSnap Organizer.

A "JPEG (Save together)" file consists of multiple images that are scanned with ScanSnap Connect Application.
What You Can Do with CardMinder

CardMinder is an application used for displaying, organizing, and managing card image data scanned with the ScanSnap.

This application digitalizes large amounts of business cards into images at a high speed and recognizes text on those cards, thus allowing you to search for your clients' business cards from those data quickly, and create your client databases conveniently. CardMinder uses an Optical Character Recognition (OCR) engine to recognize text on cards and shares the data with Personal Information Manager (PIM) applications.

CardMinder also enables business card data to be quickly searched from other applications.

- "Basic Operation Procedure of CardMinder" (page 76)
- "Linking Card Data with Other Applications" (page 79)
- "Searching Card Data with the Basic Search Toolbar" (page 80)
- "Searching Card Data with Keyboard Shortcuts" (page 81)
• " Attaching a File to Card Data" (page 82)
Basic Operation Procedure of CardMinder

This section explains the basic operation procedure of CardMinder.

1. **Start CardMinder.**
   From the sidebar in Finder, select [Applications] → [CardMinder], and then double-click [CardMinder].

![CardMinder Interface]

2. **Scan a card with the ScanSnap.**
   Load a card in the ScanSnap and press the [Scan] button to start scanning the card.
   When scanning is complete, the information printed on the card (such as name, company, and address) is automatically recognized as text and displayed in the Card Data Edit view.
   The image data scanned from the card is displayed in the Card Image view.

   **ATTENTION**
   ScanSnap Manager must be installed on your computer when you want to recognize the following languages:
   - Chinese (simplified)
   - Chinese (traditional)
   - Korean

3. **Check the card data.**
   Make sure that the front and back card images are correct, and that the text on the card images are displayed correctly in the Card Data Edit view.
4. If the language to be used for text recognition is different, perform text recognition again in the following procedure:

   ⇒ The [General] window appears.

2. Select a language for the character strings to be recognized from [Recognition Language].
   ⇒ The recognition language changes.


4. Click the [Recognize] button on the Toolbar again.
   ⇒ Character strings on the card data will be recognized as the selected language.
5. **Correct the card data, if necessary.**

The card data can be corrected in the following ways. For details, refer to the CardMinder Help.

- Redoing the recognition process on the character strings in the selected areas
- Entering text directly in the Card Data Edit view
- Correcting the orientation of the card image or switching the front and back images

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Using the [Rotate] button, you can rotate the card image.</td>
</tr>
<tr>
<td>2</td>
<td>Using the [Modify Image] button, you can switch the front and back images of the card image, create double-sided cards, and delete the back image.</td>
</tr>
<tr>
<td>3</td>
<td>By selecting character strings in the card image and then clicking the buttons of the appropriate fields in the Card Data Edit view, you can redo the recognition process on the selected areas.</td>
</tr>
<tr>
<td>4</td>
<td>You can directly correct the text of each field in the Card Data Edit view.</td>
</tr>
</tbody>
</table>

6. **Exit CardMinder.**

Click the following buttons on the Toolbar to use card data in a variety of applications.
The following explains an example in which the Toolbar is customized to display the [Application]
button.

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>E-mail</td>
<td>You can start an e-mail program, using the e-mail address specified in [E-mail] for the card data as the destination address.</td>
</tr>
<tr>
<td>2</td>
<td>Internet search</td>
<td>You can search the URL specified in [Website] for the card data with a web browser.</td>
</tr>
<tr>
<td>3</td>
<td>Outputting card data in a different format</td>
<td>You can output card data in the vCard, CSV, text, or ContactXML format.</td>
</tr>
<tr>
<td>4</td>
<td>Linking card data with another application</td>
<td>You can link card data with another application such as Outlook or Salesforce CRM to use the card data in the linked application. You can also link card data with USB media to use the card data on a different computer.</td>
</tr>
</tbody>
</table>

For details, refer to CardMinder Help.
Searching Card Data with the Basic Search Toolbar

This section explains how to search card data with the CardMinder Basic Search Toolbar.

To search card data, type in a search term (such as an individual name or a company name) in the Basic Search Toolbar.

The search results are displayed in the Card Data List view.
Searching Card Data with Keyboard Shortcuts

Even when CardMinder is not running, you can search card data by using a character string in another application (such as TextEdit) as the keyword for searching.

1. Drag the mouse to select a character string you want to search for.

2. Press [command ⌘] + [shift] + [&] keys on the keyboard at the same time.
   - While the Card Data Edit view is hidden, CardMinder starts and search is executed.
   - Card data matching the search conditions is displayed in the Card Data List view.

HINT

- Depending on the keyboard type, you may not have to press the [shift] key.
- If the keyboard shortcuts do not work, check the [Search Selected Text in CardMinder] shortcut key by selecting [System Preferences] → [Keyboard] → [Services] in the [Keyboard Shortcuts] tab, and change the shortcut key to the one to be used.
Attaching a File to Card Data

A file can be attached to card data easily by dragging and dropping it.
Useful Usages

This section explains how to use related software for the scanned image that is created after a document is scanned with the ScanSnap and how to scan a document with a setting other than the default setting.

- "Managing Paper Documents by Folder on a Computer" (page 84)
- "Saving Business Cards to a Computer" (page 87)
- "Scanning Documents Larger Than A4 or Letter Size (with the Carrier Sheet)" (page 90)
- "Scanning Documents Such as Photographs and Clippings" (page 95)
Managing Paper Documents by Folder on a Computer

This section explains how to digitize paper documents and manage the data by folder in ScanSnap Organizer.

1. **Scan a paper document with the ScanSnap.**
   For details about scanning a document, refer to "Scanning a Document" (page 17).
   ➤ The Quick Menu appears.

2. **Click the [ScanSnap Organizer] icon in the Quick Menu.**
   ➤ The [ScanSnap Organizer] window appears.
3. **From the menu bar, select [File] → [New Folder].**
   
   A new folder is created in the folder list.

4. **Rename the created folder.**

   **HINT**

   To create multiple folders, repeat steps 3 to 4.

5. **Select the scanned image from the file list, and drag and drop it to the folder.**
The scanned image is moved to the folder.

**HINT**
For details about other functions, refer to the ScanSnap Organizer Help.
This section explains how to digitize business cards and save the card data in CardMinder.

**ATTENTION**
If you do not log in as a user with Administrator privileges, you may not be able to link the ScanSnap with another application properly.

1. **Scan business cards with the ScanSnap.**
   For details about scanning business cards, refer to the following.
   - "Scanning a Document" (page 17)
   - "Scanning Documents with the ScanSnap by Inserting Two Documents at a Time or by Inserting the Next Document While the Current Document Is Being Scanned" (page 22)
   ⇨ The Quick Menu appears.

2. **Click the [CardMinder] icon in the Quick Menu.**
   ⇨ The [CardMinder] window appears.
3. **Check the card data.**

Make sure that the text on the card images are displayed correctly in the Card Data Edit view. If the card data must be corrected, click the text to be corrected and then directly edit it.
HINT

When you scan double-sided business cards, you must scan one side of each card and edit the card data in CardMinder.

For details, refer to the CardMinder Help.
Scanning Documents Larger Than A4 or Letter Size (with the Carrier Sheet)

Documents larger than A4/Letter size (such as A3, 11 × 17 in. and B4) can be scanned with the optional Carrier Sheet. By folding the document in half and scanning both sides, one at a time, the two sides are merged into a single image.

For details about documents that can be loaded, refer to "Documents That Can Be Scanned Using the Carrier Sheet" (page 66).

**ATTENTION**
The [Deskew by text on document] checkbox in the [Scanning mode option] window will be disabled. To open the [Scanning mode option] window, click the [Option] button in the [Scanning] tab of the "ScanSnap Setup Window" (page 44).

**HINT**
Both sides of a double-sided A4/Letter size document or smaller can also be scanned and merged into a single image.

1. Click the ScanSnap Manager icon 🛒 in the Dock while holding down the [control] key on the keyboard, and then select [Settings] from the "ScanSnap Manager Menu" (page 42).
   ↩️ The ScanSnap setup window appears.

2. In the [Paper] tab, select [Automatic detection] in [Paper size], and then click the [Carrier Sheet Settings] button.

   ![Carrier Sheet Settings](image)

   ↩️ The [Carrier Sheet Settings] window appears.
3. **Select [one double-page spread image] in [Save as] and click the [OK] button.**
   For details, refer to the ScanSnap Manager Help.

4. **Click the [Apply] button in the ScanSnap setup window.**

5. **Click at the upper left of the window to close the ScanSnap setup window.**

6. **Place the document inside the Carrier Sheet.**
   1. Fold the document in half with the sides to be scanned facing out.
      Fold it tightly and smooth out any creases.

   2. Open the Carrier Sheet to bind the document.
      Align the fold line with the right edge of the Carrier Sheet so that the document fits in the upper right-hand corner of the Carrier Sheet.
HINT
Note that the front side of the Carrier Sheet has a black and white pattern at the top and a thick vertical line in the upper right-hand corner.

7. Insert the part with the black and white pattern straight into the feeding section of the ScanSnap, with the front side of the Carrier Sheet facing up.

HINT
If you perform a scan using the Carrier Sheet with the output guide open, a paper jam may occur and damage the documents. Make sure to close the output guide when you perform a scan using the Carrier Sheet.

8. Press the [Scan/Stop] button on the ScanSnap to start scanning.

- Scanning starts and the [ScanSnap Manager - Image scanning and file saving] window appears. When the front side of the Carrier Sheet is scanned, the scanned image is displayed in the preview area.
9. Turn over the Carrier Sheet and insert it as described in step 7.

**ATTENTION**
Make sure to scan the front and back side of the Carrier Sheet consecutively.

- Scanning starts automatically and the [ScanSnap Manager - Image scanning and file saving] window appears. When scanning is completed, scanned images of the front and back side of the document inside the Carrier Sheet are displayed as a double-page spread image in the preview area.

**HINT**
Repeat steps 6 to 9 to scan more documents larger than A4/Letter size. You can continue to scan documents that can be inserted directly in the ScanSnap.

For details about scanning a document, refer to "Scanning a Document" (page 17).
10. Press the [Scan/Stop] button on the ScanSnap to finish scanning.
   
   The scanned images of the front and back sides of the document are saved as a double-page spread image.

ATTENTION

- There may be a line or a gap appearing between the front and back side images. Also when you scan a thick document in the Carrier Sheet, the scanned image on the left and the scanned image on the right of a double-page spread image may skew towards each other from the top. These symptoms may be improved when you place the document in the Carrier Sheet as follows:
  - Fold the document properly
  - Neatly align the edges of the document with the edges of the Carrier Sheet
  - Turn over the Carrier Sheet to the other (reverse) side

- If [Automatic detection] is specified for [Paper size] in the [Carrier Sheet Settings] window, an optimal size will be selected automatically from the available standard sizes (A3, B4, or 11 × 17 in.) in [Paper size]. Note that the size of the image may become smaller than the original document depending on the document.

  Example: When characters and illustrations are printed to fit in A4 size in the center of an A3 size document, the scanned image is output in B4 size.

  To output the scanned image in its original size, specify the document size in [Paper size].

- Part of the scanned image around where the document is folded may appear missing. In that case, place the document so that its edge is about 1 mm (0.04 in.) inside from the edge of the Carrier Sheet.
Scanning Documents Such as Photographs and Clippings

Using the optional Carrier Sheet allows you to scan documents that can be damaged quite easily such as photographs, or non-standard size documents that are difficult to load directly such as clippings.

For details about documents that can be loaded, refer to "Documents That Can Be Scanned Using the Carrier Sheet" (page 66).

**ATTENTION**
The [Deskew by text on document] checkbox in the [Scanning mode option] window will be disabled.

To open the [Scanning mode option] window, click the [Option] button in the [Scanning] tab of the "ScanSnap Setup Window" (page 44).

1. Click the ScanSnap Manager icon in the Dock while holding down the [control] key on the keyboard, and then select [Settings] from the "ScanSnap Manager Menu" (page 42).
   ↦ The ScanSnap setup window appears.

2. In the [Paper] tab, select [Automatic detection] in [Paper size], and then click the [Carrier Sheet Settings] button.

3. Select [two separate images (front and back)] in [Save as] and click the [OK] button.
   For details, refer to the ScanSnap Manager Help.
4. Click the [Apply] button in the ScanSnap setup window.

5. Click at the upper left of the window to close the ScanSnap setup window.

6. Place the document inside the Carrier Sheet.
   Open the Carrier Sheet and place the top of the document against the top center of the Carrier Sheet.

7. Insert the part with the black and white pattern straight into the feeding section of the ScanSnap, with the scanning side of the document inside the Carrier Sheet facing up.
The Carrier Sheet is pulled in until it is set inside the ScanSnap.

**ATTENTION**
If you perform a scan using the Carrier Sheet with the output guide open, a paper jam may occur and damage the documents. Make sure to close the output guide when you perform a scan using the Carrier Sheet.

8. **Press the [Scan/Stop] button on the ScanSnap to start scanning.**
   - When scanning is complete, the scanned image of the document that is inside the Carrier Sheet is displayed in the preview area.

**HINT**
Repeat steps 6 to 8 to scan more documents such as photographs and clippings.
You can continue to scan documents that can be inserted directly in the ScanSnap.
For details about scanning a document, refer to "Scanning a Document" (page 17).

9. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

 The scanned image is saved.

ATTENTION

- The scanned image is output at the center of the page in the size specified for [Paper size] in the [Carrier Sheet Settings] window.
- If [Automatic detection] is specified for [Paper size] in the [Carrier Sheet Settings] window, an optimal size will be selected automatically from the available standard sizes (A3, B4, or 11 × 17 in.) in [Paper size]. Note that the size of the image may become smaller than the original document depending on the document scanned, or part of the image may appear missing.

Example: When the contents are printed to fit in A5 size in the center of an A4 size document, the scanned image is output in A5 size.

To output the scanned image in its original size, specify the document size in [Paper size].

HINT

In the following cases, place a blank (white) sheet of paper underneath the document when scanning:

- The scanned image is not saved in the correct size (when [Automatic detection] is selected for [Paper size] in the [Carrier Sheet Settings] window)
- Shadows appear around the edges of the scanned image
- Black lines appear around the edges of a uniquely shaped cutting
This section explains how to solve troubles you may encounter upon installing the software related to the ScanSnap.

- "If You Have Installed the Software Before" (page 100)
- "When the ScanSnap Manager Icon Does Not Appear" (page 101)
- "When ScanSnap Manager Does Not Operate Normally" (page 103)

For details about the troubles you may encounter and the solutions while using the ScanSnap, refer to the following:

- "Troubleshooting" in the ScanSnap Manager Help

To display this section, click the ScanSnap Manager icon in the Dock while holding down the [control] key on the keyboard, and select [Help] → [Troubleshooting] from the "ScanSnap Manager Menu" (page 42).

- ScanSnap Support Site (http://scansnap.fujitsu.com/g-support/en/)

If you cannot solve the problem after referring to the above section, contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider.
If You Have Installed the Software Before

If your attempt to reinstall the software related to the ScanSnap (including models other than iX100) failed, uninstall the software and then reinstall it.

For details, refer to the following:

- "Uninstalling the Software" (page 115)
- "How to Install the Software" (page 40)
When the ScanSnap Manager Icon Does Not Appear

This section explains how to troubleshoot when the ScanSnap Manager icon does not appear in the Dock even though the software is installed and the ScanSnap is connected to the computer.

- "Displaying the ScanSnap Manager Icon" (page 102)
Displaying the ScanSnap Manager Icon

1. From the sidebar in Finder, select [Applications] → [ScanSnap], and then double-click [ScanSnap Manager] to start ScanSnap Manager.

   **HINT**
   
   If the problem is solved, you can change the setting so that ScanSnap Manager will start up automatically from the next time you log in to the computer.
   
   The procedure is as follows.

   - On the [System Preferences] window displayed from the Apple (🍎) menu, select [Users & Groups] → [Current User] → [Login Items] → [+] → [ScanSnap] → [ScanSnap Manager].

   - Click the ScanSnap Manager icon in the Dock while holding down the [control] key on the keyboard, and then select [Options] → [Open at Login] from the displayed menu.

If the problem persists, refer to "When ScanSnap Manager Does Not Operate Normally" (page 103).
When ScanSnap Manager Does Not Operate Normally

If the ScanSnap Manager icon in the Dock is displayed as even though the software is installed and the ScanSnap is connected to the computer, perform the following procedures.

- "Checking the Connection between the ScanSnap and the Computer" (page 104)
- "Checking If ScanSnap Manager Is Operating Normally" (page 105)
Checking the Connection between the ScanSnap and the Computer

1. Unplug the USB cable from the computer and the ScanSnap, then plug it back in.
   Make sure to leave at least 5 seconds between unplugging and plugging the cable.
   If you are using a USB hub, connect the USB cable to the computer directly.

If the problem persists, refer to "Checking If ScanSnap Manager Is Operating Normally" (page 105).
Checking If ScanSnap Manager Is Operating Normally

1. Turn off the ScanSnap and then turn it on again.
   Make sure to leave at least 5 seconds between turning off and on the ScanSnap.
   If the problem persists, proceed to step 2.

2. If you are using a USB hub, connect the ScanSnap to the computer directly with a USB cable.
   If the problem persists, proceed to step 3.

3. Turn off the ScanSnap and restart the computer.

   If the problem persists, refer to "If You Have Installed the Software Before" (page 100). If the problem still persists, perform the procedures described in "When ScanSnap Manager Does Not Operate Normally" (page 103) once again.
This section explains about the cleaning materials and how to clean the ScanSnap.

- "Cleaning Materials" (page 107)
- "Cleaning the Outside of the ScanSnap" (page 108)
- "Cleaning the Inside of the ScanSnap" (page 109)
- "Cleaning the Carrier Sheet" (page 112)
Cleaning Materials

Cleaning materials and their part numbers are as below.

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Part No.</th>
<th>Unit</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cleaner F1</td>
<td>PA03950-0352</td>
<td>1 bottle</td>
<td>Size: 100 ml</td>
</tr>
<tr>
<td>Cleaning Paper (*1)</td>
<td>CA99501-0012</td>
<td>1 pack</td>
<td>10 sheets</td>
</tr>
<tr>
<td>Cleaning Wipe (*2)</td>
<td>PA03950-0419</td>
<td>1 pack</td>
<td>24 packets</td>
</tr>
<tr>
<td>Lint-free dry cloth (*3)</td>
<td>Commercially available</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

*1: Used with Cleaner F1.

*2: The cleaning wipes are wet tissues that have been soaked with Cleaner F1. In place of this product, you can use a cloth soaked with Cleaner F1.

*3: Any lint-free cloth can be used.

Contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider for details about purchasing the cleaning materials.

For details, refer to the following web page:

http://scansnap.fujitsu.com/
Cleaning the Outside of the ScanSnap

Clean the outside of the ScanSnap in the following procedure.

1. **Unplug the cables from the ScanSnap.**

2. **Clean the outside of the ScanSnap with a dry cloth, or a cloth moistened with Cleaner F1/mild detergent.**

**ATTENTION**
- Never use paint thinner or any other organic solvents. The shape or color may be changed.
- When cleaning the ScanSnap, prevent liquids from entering the ScanSnap.
- It may take a long time for Cleaner F1 to dry if an excessive amount is used. Moisten the cloth with moderate quantity. Wipe off the cleaner completely with a soft cloth to leave no residue on the cleaned parts.
Cleaning the Inside of the ScanSnap

Scanning repeatedly may cause dust and paper dust to accumulate inside the ScanSnap resulting in a scanning error.

As a guideline, the inside of the ScanSnap should be cleaned every 100 sheets scanned. Note that this guideline varies depending on the types of documents you scan. For instance, it may be necessary to clean the scanner more frequently when you scan documents on which the toner is not sufficiently fused.

Do not use aerosol spray or spray that contains alcohol to clean the scanner. Paper dust and other dust blown up by strong air from the spray may enter inside of the scanner which may cause scanner failure or malfunction.

Also note that sparks generated by static electricity may cause a fire.

ATTENTION

- Do not use water or mild detergent to clean the inside of the ScanSnap.
- It may take a long time for Cleaner F1 to dry if an excessive amount is used. Moisten the cloth with moderate quantity.

Wipe off the cleaner completely to leave no residue on the cleaned parts.

HINT

To check the number of sheets scanned with the ScanSnap, see [Total Page Count] in the [ScanSnap Manager - Scanner and driver information] window.

To open the [ScanSnap Manager - Scanner and driver information] window, click the ScanSnap Manager icon in the Dock while holding down the [control] key on the keyboard, and click [Help] → [ScanSnap information] from the "ScanSnap Manager Menu" (page 42).

1. **Clean the glass and idler rollers.**

   1. Open the feed guide.
      The ScanSnap is turned on and a roller rotation sound comes out of the ScanSnap.
      After the sound stops, proceed to the next step.

   2. Open the top cover and output guide.
3. Clean the following locations with a cloth moistened with Cleaner F1.

- Glass (x 2, one on the top cover and one on the opposite side)
  Gently wipe the dirt and dust off the surface of the glass sections.
- Idler roller (x 12, located on the top cover)
  Gently wipe the dirt and dust off the rollers as you rotate them manually. Be careful not to damage the surface of the rollers. Make sure that they are cleaned properly because residue on the rollers will affect the feeding performance.

2. **Clean the feed roller and eject roller.**
   1. Press the [Scan/Stop] button for three seconds with the top cover open.
   2. Clean the following locations with a cloth moistened with Cleaner F1.

- Feed roller (x 1)
  Press the [Scan/Stop] button to rotate the roller. Gently wipe the dirt and dust off while taking care not to damage the surface of the roller. Make sure that they are cleaned properly because residue on the roller will affect the feeding performance.
- Eject roller (x 1)
  Press the [Scan/Stop] button to rotate the roller. Gently wipe the dirt and dust off while taking care not to damage the surface of the roller. Make sure that they are cleaned properly because residue on the roller will affect the feeding performance.
If eject roller is difficult to clean, try cleaning it from the back while you keep the top cover slightly open.

HINT
Pressing the [Scan/Stop] button seven times will rotate the feed roller and the eject roller one revolution.

3. Close the top cover and the output guide.

It clicks when it returns to its original position.

ATTENTION
Make sure that the top cover is completely closed.
Otherwise, paper jams or other feeding errors, or image faults may occur.
Cleaning the Carrier Sheet

As you keep using the Carrier Sheet, dirt and dust will accumulate on the surface and the inside. Clean the Carrier Sheet regularly because it may result in scanning errors. The procedure for cleaning the Carrier Sheet is as follows.

Cleaning

Gently wipe the dirt and dust off the surface and the inside of the Carrier Sheet with a dry cloth, or a cloth moistened with Cleaner F1/mild detergent.

**ATTENTION**

- Do not use paint thinner or any other organic solvents.
- Do not use force to rub. The Carrier Sheet may be damaged or deformed.
- Be careful not to leave any crease on the Carrier Sheet.
- After cleaning the inside of the Carrier Sheet with a cloth moistened with Cleaner F1/mild detergent, make sure that it is completely dry before closing the Carrier Sheet.
- The Carrier Sheet should be replaced approximately every 500 scans.
Appendix

- "Updating the Software" (page 114)
- "Uninstalling the Software" (page 115)
- "Specifications of Optional Parts" (page 122)
- "Specifications of Wireless LAN" (page 123)
- "Specifications of the ScanSnap" (page 124)
Updating the Software

Latest updates for ScanSnap related software are available for free from our download server. This is called ScanSnap Online Update.

It is recommended that you apply latest updates to enhance security, operability and functions.

For the software programs that can be updated, refer to the following:


ScanSnap Online Update checks the download server periodically.

When the latest version of ScanSnap is available, the update list window appears.

To install the update, follow the instructions on the window.

For details, refer to the ScanSnap Online Update Help.

You can also manually check from ScanSnap Manager whether a newer version of the program is available and run the update.

1. Click the ScanSnap Manager icon in the Dock while holding down the [control] key on the keyboard, and click [Help] → [Online Update] from the "ScanSnap Manager Menu" (page 42).

   ScanSnap Online Update checks whether a newer version of ScanSnap Manager is available. Proceed with the update as you follow the instructions.

   For details, refer to the ScanSnap Online Update Help.

ATTENTION

- To run the online update for ScanSnap Manager, you need to have access to the Internet.
- Log in as a user with Administrator privileges.

HINT

For details about updates of ScanSnap Manager, visit the following web pages:

http://scansnap.fujitsu.com/g-support/en/
Uninstalling the Software

This section explains how to uninstall the following software programs:

- "Uninstalling ScanSnap Manager" (page 116)
- "Uninstalling ScanSnap Organizer" (page 118)
- "Uninstalling CardMinder" (page 119)
- "Uninstalling ABBYY FineReader for ScanSnap" (page 120)
- "Uninstalling ScanSnap Online Update" (page 121)
Uninstalling ScanSnap Manager

Uninstall ScanSnap Manager.
The procedure is as follows.

1. **Turn on the computer and log in as a user with Administrator privileges.**

2. **From the sidebar in Finder, select [Applications] → [ScanSnap] → [Sub], and then double-click [ScanSnap Uninstaller].**
   - The [ScanSnap Uninstaller] window (the [Welcome to ScanSnap Uninstaller] screen) appears.

3. **Click the [Continue] button.**
   - The [Important Information] screen appears.

4. **Read [Read Me], and then click the [Uninstall] button.**
   - The authentication window appears.

5. **Enter the user name and password for a user with Administrator privileges, and click the [OK] button.**
   - Uninstallation starts. When the uninstallation is complete, [Uninstall Succeeded] screen appears.

6. **Click the [Close] button.**

**HINT**

When a user other than the user who uninstalled ScanSnap Manager has set ScanSnap Manager as a login item, the following operations are required:

1. Log in as a user who has set ScanSnap Manager as a login item.

2. From the Apple (🍎) menu, select [System Preferences].
   - The [System Preferences] window appears.

3. Select [Users & Groups].
   - The [Users & Groups] window appears.

4. From [Current User], select the currently logged-in user.

5. Select the [Login Items] tab.
   - A list of login items appears.

6. From the list of login items, select [ScanSnap Manager].

7. Click the [−] button under the list of login items.
   - [ScanSnap Manager] is deleted from the list of login items.
Uninstalling ScanSnap Organizer

Uninstall ScanSnap Organizer.
The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit ScanSnap Organizer if it is running.

3. From the sidebar in Finder, select [Applications] → [ScanSnap Organizer], and drag the [ScanSnap Organizer] folder into the Trash.

4. Empty the Trash.
   ✤ The [ScanSnap Organizer] folder is deleted.
Uninstalling CardMinder

Uninstall CardMinder.
The procedure is as follows.

1. **Turn on the computer and log in as a user with Administrator privileges.**

2. **Exit CardMinder if it is running.**

3. **From the sidebar in Finder, select [Applications] → [CardMinder], and drag the [CardMinder] folder into the Trash.**

4. **Empty the Trash.**
   - The [CardMinder] folder is deleted.

**HINT**
To delete the database, drag the database file into the Trash.
To access the database file stored in the default location, select [Documents] → [CardMinder] → [CardMinder DB.cxdb] from the sidebar in Finder.
Uninstalling ABBYY FineReader for ScanSnap

Uninstall ABBYY FineReader for ScanSnap.
The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit ABBYY FineReader for ScanSnap if it is running.

3. From the sidebar in Finder, select [Applications] → [ABBYY FineReader for ScanSnap], and drag the [ABBYY FineReader for ScanSnap] folder into the Trash.

4. Empty the Trash.
   ⇨ The [ABBYY FineReader for ScanSnap] folder is deleted.
Uninstalling ScanSnap Online Update

Uninstall ScanSnap Online Update.

HINT
Before uninstalling ScanSnap Online Update, make sure that none of the following software is installed.

- ScanSnap Manager
- ScanSnap Organizer
- CardMinder

The procedure is as follows.

1. **Turn on the computer and log in as a user with Administrator privileges.**

2. **From the sidebar in Finder, select [Applications] → [ScanSnap Online Update] → [Sub], and then double-click [AOUUninstaller].**
   
   The [ScanSnap Online Update Uninstaller] window ([Welcome to ScanSnap Online Update Uninstaller]) appears.

3. **Click the [Continue] button.**
   
   The [Important Information] screen appears.

4. **Read [Read Me], and then click the [Uninstall] button.**
   
   The authentication window appears.

5. **Enter the user name and password for a user with Administrator privileges, and click the [OK] button.**
   
   Uninstallation starts. When the uninstallation is complete, [Uninstall Succeeded] screen appears.
Specifications of Optional Parts

The product names of optional parts are as follows.

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>ScanSnap iX100 Case</td>
<td>Useful for carrying the ScanSnap.</td>
</tr>
<tr>
<td>ScanSnap iX100 Soft Case</td>
<td></td>
</tr>
<tr>
<td>USB CABLE</td>
<td></td>
</tr>
<tr>
<td>ScanSnap iX100 Feed Guide</td>
<td></td>
</tr>
<tr>
<td>ScanSnap iX100 Output Guide</td>
<td></td>
</tr>
<tr>
<td>USB POWER ADAPTER</td>
<td>The AC adapter may vary depending on the country where you purchased the ScanSnap and the specifications of the ScanSnap.</td>
</tr>
<tr>
<td>ScanSnap Carrier Sheets</td>
<td>5 sheets</td>
</tr>
</tbody>
</table>

Contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider for details about purchasing the optional parts.

For details, refer to the following portal site:

http://scansnap.fujitsu.com/
Specifications of Wireless LAN

The following table summarizes the wireless LAN specifications of the ScanSnap.

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model name</td>
<td>iX100</td>
</tr>
<tr>
<td>Observed standards</td>
<td>IEEE802.11b/IEEE802.11g/IEEE802.11n</td>
</tr>
<tr>
<td>Frequency range</td>
<td>2.412 GHz to 2.472 GHz</td>
</tr>
<tr>
<td>Channels</td>
<td>Access Point Connect mode: 1 to 13 ch</td>
</tr>
<tr>
<td></td>
<td>Direct Connect mode: 1 to 11 ch</td>
</tr>
<tr>
<td>Transfer speed (standard)</td>
<td>IEEE802.11b Max.: 11 Mbps</td>
</tr>
<tr>
<td></td>
<td>IEEE802.11g Max.: 54 Mbps</td>
</tr>
<tr>
<td></td>
<td>IEEE802.11n Max.: 72.2 Mbps (Only supports 20 MHz bandwidth) (*1)</td>
</tr>
<tr>
<td>Communication mode</td>
<td>Access Point Connect mode (infrastructure) (*2)</td>
</tr>
<tr>
<td></td>
<td>Direct Connect mode (access point)</td>
</tr>
<tr>
<td>Communication distance</td>
<td>Indoors, 50 m (Recommended: indoors, within 25 m) (*3)</td>
</tr>
<tr>
<td>(line of sight)</td>
<td></td>
</tr>
<tr>
<td>Security</td>
<td>Access Point Connect mode</td>
</tr>
<tr>
<td></td>
<td>WPA-PSK (TKIP/AES), WPA2-PSK (TKIP/AES), WPA (TKIP/AES), WPA2 (TKIP/AES), WEP (64-bit/128-bit) (*4)</td>
</tr>
<tr>
<td></td>
<td>Direct Connect mode</td>
</tr>
<tr>
<td></td>
<td>WPA-PSK (TKIP/AES), WPA2-PSK (TKIP/AES), WEP (64-bit/128-bit)</td>
</tr>
<tr>
<td>Easy installation</td>
<td>WPS 2.0 supported (button/PIN code) (*5)</td>
</tr>
</tbody>
</table>

*1: The values indicated on these standards are the maximum value, and do not indicate actual communication speed.

*2: To use the wireless function, you need a wireless access point that supports the same standards.

*3: The specifications may vary based on the connected wireless access point and the surrounding environment.

*4: The following EAP types are supported.

   EAP-MD5, PEAPv0, EAP-TLS, EAP-TTLS, EAP-FAST, LEAP

*5: You need a wireless access point or wireless client that supports the WPS function.
### Specifications of the ScanSnap

The following table summarizes the specifications of the ScanSnap.

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Product Name</strong></td>
<td>ScanSnap iX100</td>
</tr>
<tr>
<td><strong>Scanning method</strong></td>
<td>Manual feed (Continuous Document Feeding (CDF) function supported), simplex scanning, two selectable paper paths (U-turn path (*1), straight path (*2))</td>
</tr>
<tr>
<td><strong>Scanning color mode</strong></td>
<td>Simplex, color/gray/black and white/auto (automatic color, gray, and B&amp;W detection)</td>
</tr>
<tr>
<td><strong>Optical system/image sensor</strong></td>
<td>Selfoc lens equal-magnification optics/color CIS × 1</td>
</tr>
<tr>
<td><strong>Light source</strong></td>
<td>3 color LED (Red/Green/Blue)</td>
</tr>
<tr>
<td><strong>Scanning speed (A4 portrait)</strong></td>
<td><strong>Automatic resolution/normal/better/best</strong>&lt;br&gt;5.2 sec/sheet&lt;br&gt;&lt;br&gt;<strong>Excellent</strong>&lt;br&gt;20.4 sec/sheet</td>
</tr>
<tr>
<td><strong>Scan area</strong></td>
<td>Refer to &quot;Documents to Scan&quot; (page 63)</td>
</tr>
<tr>
<td><strong>Document thickness</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Interface</strong></td>
<td>USB</td>
</tr>
<tr>
<td><strong>USB</strong></td>
<td>USB 2.0/USB 1.1 (connector: USB Micro-B type) (*3)</td>
</tr>
<tr>
<td>*<em>Wireless LAN (<em>4)</em></em></td>
<td>Refer to &quot;Specifications of Wireless LAN&quot; (page 123)</td>
</tr>
<tr>
<td><strong>Input power</strong></td>
<td>Voltage&lt;br&gt;5 V (USB bus power)</td>
</tr>
<tr>
<td><strong>Power consumption</strong></td>
<td>During operation: 4.7 W or less&lt;br&gt;During sleep mode: 2.2 W or less</td>
</tr>
<tr>
<td><strong>Temperature/humidity allowable ranges</strong></td>
<td>During operation: 5 to 35 degrees C/41 to 95 degrees F&lt;br&gt;During standby: -20 to 60 degrees C/-4 to 140 degrees F&lt;br&gt;During storage/transportation: -20 to 60 degrees C/-4 to 140 degrees F</td>
</tr>
<tr>
<td><strong>Humidity</strong></td>
<td>During operation: 20 to 80%&lt;br&gt;During standby: 8 to 95%&lt;br&gt;During storage/transportation: 8 to 95%</td>
</tr>
<tr>
<td><strong>Outer dimensions (Width × Depth × Height)</strong></td>
<td>Min.: 273 × 47.5 × 36 mm/10.75 × 1.87 × 1.42 in. (when the feed guide and output guide are closed)&lt;br&gt;Max.: 273 × 80 × 59 mm/10.75 × 3.15 × 2.32 in. (when the feed guide and output guide are open)</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>400 g (approx. 0.88 lb)</td>
</tr>
<tr>
<td><strong>Environmental specification</strong></td>
<td>Compliant with the International Energy Star Program, and RoHS Directive</td>
</tr>
<tr>
<td><strong>Related Software</strong></td>
<td><strong>Scanner driver</strong>&lt;br&gt;ScanSnap Manager&lt;br&gt;&lt;br&gt;<strong>File management</strong>&lt;br&gt;ScanSnap Organizer&lt;br&gt;&lt;br&gt;<strong>Business card management</strong>&lt;br&gt;CardMinder&lt;br&gt;&lt;br&gt;<strong>Text recognition</strong>&lt;br&gt;ABBYY FineReader for ScanSnap&lt;br&gt;&lt;br&gt;<strong>Update management and application</strong>&lt;br&gt;ScanSnap Online Update</td>
</tr>
</tbody>
</table>

*1: When the output guide is open.
*2: When the output guide is closed.
*3: When the ScanSnap is connected to a USB 3.0 port, the port operates as a USB 2.0 port.
*4: IPv6 is not supported.
About Customer Support and Maintenance

Customer Support

- ABBYY FineReader for ScanSnap
  From the sidebar in Finder, select [Applications] → [ABBYY FineReader for ScanSnap] → [ABBYY FineReader for ScanSnap] → [Help] → [ABBYY FineReader for ScanSnap Help] → [Technical Support].

- Evernote
  Refer to the following web page:
  http://www.evernote.com/about/contact/support/

- Google Drive
  Refer to the Google Drive Help Center or the Google Product Forums.
  To open them, select [Help] in Google Drive.

- Salesforce
  Contact the system administrator of your Salesforce.

- Dropbox
  Refer to the following web page:
  http://www.dropbox.com/contact

- ScanSnap
  For other inquiries on the ScanSnap, refer to the ScanSnap Support Site.
  http://scansnap.fujitsu.com/g-support/en/
  If your problem cannot be solved after referring to the above web pages, visit the following web page to check the contact information of a suitable Fujitsu office and contact the Fujitsu office.
  http://imagescanner.fujitsu.com/warranty.html

Suppliers of Consumables/Optional Parts

http://scansnap.fujitsu.com/

Maintenance

Contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider for repairs on this product.

For details, refer to the following portal site:
http://imagescanner.fujitsu.com/warranty.html

ATTENTION

For safety reasons, never attempt repairs by yourself.